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COMfortel® 2600

Systemtelefon
System Telephone

Betriebsanleitung Deutsch
Instructions English
Manual de instrucciones Espanol
Odnyisg Asitoupyiag EAAnvika
Notice d’utilisation Francais
Istruzioni per I'uso Italiano
Gebruikshandleiding Nederlands
Instrukcja obstugi Polski

Lieferumfang (de) / Scope of Delivery (en) / Volumen de suministro (es) /
ESomAiouég rapadoong (el) / Contenu de la livraison (fr) / Dotazione (it) /
Leveringsomvang (nl) / Zakres dostawy (pl)
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* Bereits vorinstalliert, siehe Unterseite des Gerats de
* Already preinstalled, see underside of the device en
* Ya preinstalado, véase la parte inferior del dispositivo es
* Av gival 48N TIpogykaTeaTNUEVO, BA. OTO TTIOW PEPOG TNG OUOKEURG el
* Déja pré-installé, voir le dessous de I'appareil fr
* Gia preinstallato, vedere la parte inferiore del dispositivo it
* Reeds van tevoren geinstalleerd, zie onderkant van het apparaat nl
* Juz zainstalowany, patrz spéd urzadzenia pl




Kontaktdaten (de) / Contact Data (en) / Datos de contacto (es) /
Zroixeia emikoivwviag (el) / Coordonnées (fr) / Dati di contatto (it) /
Contactgegevens (nl) / Dane potaczen (pl)

Hersteller/Manufacturer: Auerswald GmbH & Co. KG, Hordorfer Str. 36, 38162
Cremlingen, Germany

D A CH L
www.auerswald.de

B E F GB GR | NL PL
www.fontevo.com

Anleitungen (de) / Manuals (en) / Instrucciones (es) / O3nyieg xpriong (el) /
Notices (fr) / Guide (it) / Handleidingen (nl) / Instrukcje (pl)
Die Anleitung ,Erweiterte Informationen” finden Sie im COMfortel Set und auf unserer Internetseite. Die de

Kurzanleitung finden Sie auf unserer Internetseite. Nach einem Firmware-Update benétigen Sie ggf.
aktualisierte Anleitungen. Diese finden Sie auf unserer Internetseite.

You will find the "Advanced Information" manuals in the COMfortel Set software and on our website. You | en
will find the Quick Guide on our website. After a firmware update you usually require a new version of the
instructions. You will find this on our website.

Encontrara las instrucciones del apartado "Advanced Information" en COMfortel Set y en nuestra pagina | es
web. En nuestra pagina web encontrara la Guia rapida. Después de efectuar una actualizacién del
firmware es posible que necesite descargar una copia actualizada de las instrucciones. La encontrara en
nuestra pagina web.

O1 03nyieg xpriong "Advanced Information” urrépyouv oto COMfortel Set kai oo SiadikTuo. O1 cuvoTITIKEG | el
odnyieg xpriong utrdpxouv ato diadikTuo. MeTd TNV evnuépwon Tou UAIKOAOYIGHIKOU Ba XPEINOTEITE €VD.
evnuepwéveg odnyieg xpriong. Mrropeite va Tig Bpeite 070 d1adikTUO.

La notice « Advanced Information » est disponible dans le COMfortel Set ainsi que sur notre site Internet. | fr
Vous trouverez la notice abrégée sur notre site Internet. Aprés une mise a jour de la version du logiciel,
vous aurez besoin de notices actualisées. Elles sont disponibles sur notre site Internet.

La guida “Advanced Information” & disponibile in COMfortel Set e sul nostro sito web. La guida rapida & it
disponibile sul nostro sito web. Dopo un aggiornamento del firmware possono servire guide aggiornate.
Queste sono disponibili sul nostro sito web.

De handleiding “Advanced Information” vindt u in de COMfortel Set van de telefoon en op onze nl
internetpagina. Een korte handleiding vindt u op onze internetpagina. Na een firmware-update heeft u evt.
geactualiseerde handleidingen nodig. Deze vindt u op onze internetpagina.

Instrukcja ,Advanced Information” znajduje sie w COMfortel Set i na naszej stronie internetowej. Skrécona | pl
instrukcja znajduje sig na naszej stronie internetowej. Po zaktualizowaniu oprogramowania wewnetrznego
moga by¢ ewentualnie potrzebne zaktualizowane instrukcje. Mozna je znalez¢ na naszej stronie
internetowe;j.

Copyright
© Auerswald GmbH & Co. KG, 38162 Cremlingen, Germany, 2018

Trademarks

Android and Google search are trademarks of Google, Inc. Microsoft, Windows and ActiveSync are registered trademarks of
the Microsoft Corporation in the U.S.A. and/or other countries. All other trademarks mentioned are the property of the
corresponding manufacturer.

Licenses

The software included in this product contains also copyrighted software that is licenced under various licences. A copy of these licences is included in this document.



Apache License

Version 2.0, January 2004

Android Ring Tones

Copyright (c) 2009 Android Open Source Project

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License. You may obtain a copy of the License at http:/iwww.apache.orgficenses/LICENSE-2.0
Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See
the License for the specific language governing permissions and limitations under the License.

BSD License
Newilib sources licensed using BSD 3-clause license
Sources from the following contributors in the newlib subdirecory are licensed using the BSD 3-clause license:
(2) University of California, Berkeley. Copyright (c) 1981-2000 The Regents of the University of California. Allrights reserved.
(11) Christopher G. Demetriou. Copyright () 2001 Christopher G. Demetriou. Al rights reserved.
(13) Royal Institute of Technology. Copyright (c) 1999 Kungliga Tekniska Hogskolan (Royal Institute of Technology, Stockholm, Sweden). Al rights reserved.
(19) Todd C. Miller. Copyright (c) 1998 Todd C. Miller <Todd.Miller@courtesan.com>. All rights reserved.
(35) - ARM Ltd (arm and thumb variant targets only). Copyright (c) 2009 ARM Ltd. Al rights reserved.
The BSD 3-clause license
Copyright (c) <YEAR>, <OWNER> Al rights reserved,
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation andior other materials provided with the distribution.
* Neither the name of the <ORGANIZATION> nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTER-
RUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Newilib sources licensed using BSD 2-clause license
Sources from the following contributors in the newlib subdirecory are licensed using the BSD 2-clause license:
(14) Alexey Zelkin. Copyright (c) 2000, 2001 Alexey Zelkin <phantom@FreeBSD.org>. Al rights reserved
(15) Andrey A. Chermov. Copyright (C) 1997 by Andrey A. Chemov, Moscow, Russia. Al rights reserved.
(16) FreeBSD. Copyright (c) 1997-2002 FreeBSD Project. All rights reserved.
(18) Citrus Project. Copyright (c)1999 Citrus Project. All rights reserved.
(27) Konstantin Chuguev (~-enable-newlib-iconv). Copyright (c) 1999, 2000 Konstantin Chuguev. Al rights reserved.
(28) Artem Bityuckly (~enable-newiib-iconv). Copyright (c) 2003, Artem B. Bityuckiy, SoftMine Corporation. Rights transferred to Frankiin Electronic Publishers.
(26) Mike Barcroft. Copyright (c) 2001 Mike Barcroft <mike@FreeBSD.org>. All ights reserved.
(30) - Alex Tatmanjants (targets using libc/posix). Copyright (c) 1995 Alex Tatmanjants <alex@elvisti kiev.ua> at Electronni Visti 1A, Kiev, Ukraine. All rights reserved.
(31) - M. Warner Losh (targets using libciposix). Copyright (c) 1998, M. Wamer Losh <imp@freebsd.org>. Al rights reserved.
(32) - Andrey A. Chemov (targets using libc/posix). Copyright (C) 1996 by Andrey A. Chemov, Moscow, Russia. Al rights reserved.
(33) - Daniel Eischen (targets using lioc/posix). Copyright (c) 2001 Daniel Eischen <deischen@FreeBSD.org>. Al rights reserved.
The BSD 2-clause license:
Copyright (c) <YEAR>, <OWNER> Al rights reserved,
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
* Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation andior other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTER-
RUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Deja Vu License

Fonts are © Bitstream (see below). DejaVu changes are in public domain. Explanation of copyright is on Gnome page on Bitstream Vera fonts. Glyphs imported from Arev fonts are © Tavmjung Bah (see below)

Bitstream Vera Fonts Copyright

Copyright (c) 2003 by Bitstream, Inc. All Rights Reserved. Bitstream Vera is a trademark of Bitstream, Inc.

Permission , to any pe of the font this license ("Fonts") (the "Font Software”), t the Font Software,
including without lmitation the rights to use, copy, merge, publish, distribute, and/or sell copies of the Font Software, and to permit persons to whom the Font Software is fumished to do so, subject to the following conditions:
The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typef

The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified ar\d addmor\al glyphs or characters may be added to the Fonts, only if the fonts are
renamed to names not containing either the words "Bitstream” or the word "Vera".

This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the "Bitstream Vera" names.

The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itself.

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL BITSTREAM OR THE GNOME FOUNDATION BE LIABLE FOR ANY CLAIM, DAMAGES
OR OTHER LIABILITY, INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF
THE USE OR INABILITY TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.

Except as contained in this notice, the names of Gnome, the Gnome Foundation, and Bitstream Inc., shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software without prior
written authorization from the Gnome Foundation or Bitstream Inc., respectively. For further information, contact: fonts at gnome dot org.

Avev Fonts Copyright

Copyright (c) 2006 by Tavmjong Bah. All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of the fonts jing this license ("Fonts") and jated ion files (the "Font Software"), to reproduce and distribute the modifications
to the Bitstream Vera Font Software, including without limitation the rights to use, copy, merge, publish, distribute, and/or sell copies of the Font Software, and to permit persons to whom the Font Software is furnished to do so,
subject to the following conditions:

The above copyright and trademark notices and this permission notice shall be included in all copies of one or more of the Font Software typefaces,

The Font Software may be modified, altered, or added to, and in particular the designs of glyphs or characters in the Fonts may be modified and additional glyphs o characters may be added to the Fonts, only if the fonts are
renamed to names not containing either the words *Tavmjong Bah" or the word "Arev".

This License becomes null and void to the extent applicable to Fonts or Font Software that has been modified and is distributed under the “Tavmjong Bah Arev" names.

The Font Software may be sold as part of a larger software package but no copy of one or more of the Font Software typefaces may be sold by itsel.

THE FONT SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PAR-
TICULAR PURPOSE AND NONINFRINGEMENT OF COPYRIGHT, PATENT, TRADEMARK, OR OTHER RIGHT. IN NO EVENT SHALL TAVMJONG BAH BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
INCLUDING ANY GENERAL, SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF THE USE OR INABILITY
TO USE THE FONT SOFTWARE OR FROM OTHER DEALINGS IN THE FONT SOFTWARE.

Except as contained in this notice, the name of Tavmjong Bah shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Font Software without prior written authorization from Tavmjong Bah.
For further information, contact: tavmjong @ free . fr.

Freetype2-Library

Freetype credits

Portions of this software are copyright © 2014 The FreeType Project (www.freetype.org). All rights reserved.

JPEG License

This software is based in part on the work of the Independent JPEG Group.

Newlib License

The newlib subdirectory is a collection of software from several sources. Each file may have its own copyrightlicense that is embedded i the source file. Unless otherwise noted in the body of the source file(s), the following
copyright notices will apply to the contents of the newlib subdirectory:

11) Red Hat Incurpuraled Cupynght u:) 1994 2009 Red Hat, Inc. Al rights reserved

g to use, modify, copy, or redistribute it subject to the terms and conditions of the BSD License. This program is distributed in the hope that it will be useful, but WITHOUT
ANY WARRANTYexpressed or| |mp||ed, mcludlng the implied warranties of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. A copy of this license is available at http://www.opensource.org/licenses. Any Red
Hat trademarks that are incorporated in the source code or documentation are not subject to the BSD License and may only be used or replicated with the express permission of Red Hat, Inc.

The author of this software is David M. Gay.

Copyright (C) 1998-2001 by Lucent Technologies. All Rights Reserved

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright
notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software
without specific, written prior permission.

LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES
BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

(3) David M. Gay (AT&T 1991, Lucent 1998). The author of this software is David M. Gay. Copyright (c) 1991 by ATT.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS, WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.




(4) Advanced Micro Devices. Copyright 1989, 1990 Advanced Micro Devices, Inc.
This software s the property of Advanced Micro Devices, Inc: (AMD) which specifially grants the user the rightto modify, use and distribute this software provided this notie is ot removed or atered. Al fhr rights ae reserved

D,
AMD MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS SOFTWARE. IN NO EVENT SHALL AMD BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION
WITH OR ARISING FROM THE FURNISHING, PERFORMANCE, OR USE OF THIS SOFTWARE.
So that all may benefit from your experience, please report any problems or suggestions about this software to the 29K Technical Support Center at 800-29-29-AMD (800-292-9263) in the USA, or 0800-89-1131 in the UK,
0r 0031-11-1129n Japan, tol free. The direct dial number is 512-462-4118
Advanced Micro Devices, Inc., 29K Support Products, Mail Stop 573, 5900 E. Ben White Bivd., Austin, TX 78741, 800-292-9263
(7) Sun Microsystems. Copyright (c) 1993 by Sun Microsystems, Inc. Al rights reserved.
Developed at SunPro, a Sun Microsystems, Inc. business.
Permission to use, copy, modify, and distrbute ths software s freely granted, provided that this notice s preserved.
(8) Hewlett Packard. (c) Copyright 1986 HEWLETT-PACKARD COMPANY
To anyone who acknowledges that this file is provided "AS IS" without any express or implied warranty: permission to use, copy, modify, and distribute this file for any purpose is hereby granted without fee, provided that the
above copyright notice and this notice appears n all copies, and that the name of Hewlett-Packard Company not be used in advertising or publcity pertaining ibuton of the software without specifc, written pior permission.
Hewlett-Packard Company makes no representations about the suitabilty of this software for any purpose
(9) Hans-Peter Nisson. Copyright (C) 2001 Hans-Peter Nilsson
Permission to use, copy, modify, and distrbute ths software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
Software and in allcopies of the supporting documentation for such software,
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
(17)'S. L. Moshier. Author: . L. Moshier. Copyright (c) 1984,2000 S.L. Moshier
Permission to use, copy, modify, and distrbute ths software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this
software and in allcopies of the supporting documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, THE AUTHOR MAKES NO REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING
THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.




GeritefiiBe (de) / Device Stands (en) / Soportes del dispositivo (es) / Baoeig
ouokeung (el) / Pieds d’appareil (fr) / Piedini del dispositivo (it) / Voeten
apparaat (nl) / Nozki urzadzenia (pl)
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* GeratefliRe umstecken und nicht drehen de
* Unplug and reinsert device stands. Do not rotate. en
* Conecte los soportes sin girarlos es
* ETravartotroBeTAOTE TIG BACEIG GUOKEUNG KAl PNV TIG TTEPIOTPEPETE el
* Défichez les pieds d’appareil et ne les tournez pas fr
* Estrai i piedini del dispositivo e inseriscili nella posizione desiderata, non ruotarli it
* voeten apparaat herpositioneren en niet draaien nl
* Przetozy¢ nozki urzgdzenia i nie obracac¢ pl

Montage (de) / Assembly (en) / Montaje (es) / ZuvapuoAdéynon (el) / Montage
(fr) I Montaggio (it) / Montage (nl) / Montaz (pl)

Montage des Tastenerweiterungmoduls mit Spezialverbinder und Verbindungskabel (nicht im de
Lieferumfang)

Assemble the key extension module with special fasteners and connection cable (not included in the en
scope of delivery)

Montaje de la extension del teclado con conector especial y cable de conexién (no incluido) es

ZuvappoAdynon SopoaTolxeiou £TTEKTAONG TTARKTPOU He €181KO oUvdeapo Kal KaAwdio ouvdeong (dev | el
TrepIAapBaveTal oTa TTapadoTéa)

Montage du module d’extension de touches avec connecteur spécial et cable de raccordement (non fr
compris dans la livraison)

Montaggio del modulo estensione tasti con connettore speciale e cavo di collegamento (non in it
dotazione)
Montage van de toetsuitbreidingsmodule met speciale verbinder en verbindingskabel (niet bij de nl

levering inbegrepen)

Montaz modutu rozszerzenia klawiatury z tgcznikiem specjalnym i kablem potgczeniowym (nie znajduje | pl
sig w zakresie dostawy)
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* Ohne Tastenerweiterungsmodule: Briickenstecker gesteckt (Auslieferzustand) de
Mit Tastenerweiterungsmodulen: Netzteil mit der Typ-Nr. FW7577/EU/40 ist erforderlich
(nicht im Lieferumfang)

* Without key extension module: Bridge plug inserted (factory settings) en
With key extension modules: Power supply with type no. FW7577/EU/40 is required
(not included in the scope of delivery)

* Sin extensiones de teclado: conector puente conectado (configuracion de fabrica) es
Con extensiones de teclado: se requiere el transformador con n.° de modelo FW7577/EU/40
(no incluido)

* Xwpig dopoaToixeia emékraong TAfKTpou: Pig yepUpwong ouvdedepévo (kardoTaon Tapadoong) el
Me dopooToixeia eTTEKTAONG TTARKTPoU: ATraiTeital TPo@odoTIKS pe ap. Turou FW7577/EU/40
(8ev TepIAapBaveTal oTov €EOTTAIOUS TTapdadoong)

* Sans modules d’'extension de touches : cavalier enfiché (par défaut a la livraison) fr
Avec modules d’extension de touches : le bloc d’alimentation avec le no de type FW7577/EU/40
est nécessaire (non compris a la livraison)

* Senza modulo estensione tasti: Spina a ponte inserita (impostazione di fabbrica) it
Con modulo estensione tasti: E necessario un alimentatore di tipo FW7577/EU/40
(non in dotazione)

* Zonder toetsenuitbreidingsmodules: Brugstekker geplaatst (fabrieksinstelling) nl
Met toetsenuitbreidingsmodules: Voeding met type-nr. FW7577/EU/40 is vereist
(niet bij de levering inbegrepen)

* Bez modutéw rozszerzenia klawiatury: wtyk mostkujgcy wetknigty (ustawienie fabryczne) pl
Z modutami rozszerzenia klawiatury: jest wymagany zasilacz sieciowy o nr typu FW7577/EU/40
(nie znajduje sie w zakresie dostawy)




Anschluss (de) / Connection (en) / Conexion (es) / Z0vdeon (el) /
Raccordement (fr) / Collegamento (it) / Aansluiting (nl) / Przytacze (pl)

(i

* Nicht im Lieferumfang de
** Ohne Tastenerweiterungsmodule: Briickenstecker gesteckt (Auslieferzustand)

Mit Tastenerweiterungsmodulen: Steckernetzteil mit der Typ-Nr. FW7577/EU/40 ist erforderlich
(nicht im Lieferumfang)

* Not included in the scope of delivery en
**Without key extension module: Bridge plug inserted (factory settings)

With key extension modules: Power supply with type no. FW7577/EU/40 is required
(not included in the scope of delivery)

* No incluido es
**Sin extensiones de teclado: conector puente conectado (configuracion de fabrica)

Con extensiones de teclado: se requiere el transformador con n.° de modelo FW7577/EU/40
(no incluido)

* Aev ouptrepiAapBavovrtal el
** Xwpig dopoaToixeia emékTaong TARKTpou: PIg yepUipwong cuvdedepévo (KaTdoTaon Tapddoong)
Me dopooToixeia eTTékTaONG TTARKTPOU: ATTaITEiTal TPOPOBOTIKG PE ap. TOTTou FW7577/EU/40
(8ev epIAapBaveTal oTov £EOTTAIOUOS TTapdadoong)

* Non compris a la livraison fr
**Sans modules d’extension de touches : cavalier enfiché (par défaut a la livraison)

Avec modules d’extension de touches : le bloc d’alimentation avec le no de type FW7577/EU/40
est nécessaire (non compris a la livraison)

* Non in dotazione it
** Senza modulo estensione tasti: Spina a ponte inserita (impostazione di fabbrica)
Con modulo estensione tasti: E necessario un alimentatore di tipo FW7577/EU/40 (non in dotazione)

* Niet bij de levering inbegrepen nl
**Zonder toetsenuitbreidingsmodules: Brugstekker geplaatst (fabrieksinstelling)

Met toetsenuitbreidingsmodules: Voeding met type-nr. FW7577/EU/40 is vereist
(niet bij de levering inbegrepen)

* Nie znajduje sie w zakresie dostawy pl
**Bez modutéw rozszerzenia klawiatury: wtyk mostkujgcy wetknigty (ustawienie fabryczne)

Z modutami rozszerzenia klawiatury: jest wymagany zasilacz sieciowy o nr typu FW7577/EU/40
(nie znajduje sie w zakresie dostawy)

Headsetbuchse (de) / Headset Socket (en) / Conexion auriculares (es) /
Ymodoxn ot akouoTiKwy (el) / Connecteur micro-casque (fr) / Presa per



cuffia auricolare (it) / Aansluiting headset (nl) / Gniazdo zestawu
stuchawkowego (pl)

1 DHSG BUS_IN

2 DHSG GND

3 Mikrofon (de) / Microphone (en) / Micréfono (es) / Mikpégwvo (el) / Microphone (fr) / Microfono
(it) / Microfoon (nl) / Mikrofon (pl)

4 Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Hxeio (el) / Haut-parleur (fr) / Altoparlante
(it) / Luidspreker (nl) / Gtosnik (pl)

5 Lautsprecher (de) / Loudspeaker (en) / Altavoz (es) / Hyeio (el) / Haut-parleur (fr) / Altoparlante
(it) / Luidspreker (nl) / Gtosnik (pl)

6 Mikrofon (de) / Microphone (en) / Micréfono (es) / Mikpoégwvo (el) / Microphone (fr) / Microfono
(it) / Microfoon (nl) / Mikrofon (pl)

7 DHSG +3,3V

DHSG BUS_OUT



Deutsch

Wichtige Informationen

Sicherheitshinweise

Warnung: Unsachgemafier Umgang mit dem Gerat kann zu einem
lebensgefahrlichen elektrischen Schlag flihren und das Gerat
beschadigen oder zerstéren.
+ Lesen Sie die zum Gerat gehérenden Anleitungen und bewahren Sie
diese auf.
+ SchlieRen Sie die Anschlusskabel des Gerats nur an die dafir bestimmten
und fachgerecht installierten Anschlussdosen an
» Verwenden Sie ausschlieRlich Originalzubehér und Originalersatzteile.

Warnung: Unvollstédndige oder fehlerhafte Einrichtung kann zur
Gefahrdung von Personen fuhren, z. B. aufgrund nicht durchfiihrbarer
Notrufe.

+ Die Einrichtung des Produkts erfolgt Gber das Telefon oder tber die
Software COMfortel Set. Die zugehdrige Hilfe ist in englischer oder
deutscher Sprache vorhanden. Wenn Sie mit diesen Sprachen und den
verwendeten Fachbegriffen nicht vertraut sind, ziehen Sie eine fachlich
und sprachlich geeignete Fachkraft hinzu.

Warnung: Die Verwendung des falschen Netzteils kann zu einem
lebensgefahrlichen elektrischen Schlag fiihren und das Telefon
beschadigen oder zerstéren.

» Verwenden Sie nur das Netzteil Typ-Nr. FW7577/EU/40.
Warnung: In das Gehause eindringende Flussigkeiten kénnen zu

einem lebensgefahrlichen elektrischen Schlag fihren und das Gerat
beschadigen oder zerstéren.

+ Betreiben Sie das Telefon nur in geschlossenen, trockenen Raumen.
* Reinigen Sie das Gerat nur mit einem leicht feuchten Tuch oder einem
Antistatiktuch.

Warnung: Beschadigte Anschlussleitungen sowie Beschadigungen
am Gehause und am Geréat selbst kdnnen zu einem
lebensgefahrlichen elektrischen Schlag fiihren.

* Nehmen Sie ein beschadigtes Gerat nicht in Betrieb.
Warnung: Uberspannungen, wie sie bei Gewitter auftreten, kénnen

zu einem lebensgefahrlichen elektrischen Schlag fiihren oder das
Gerat beschadigen oder zerstoren.

* Verzichten Sie wahrend eines Gewitters auf das Berlihren des Gerates.

» Lassen Sie von einer Elektrofachkraft alle Kabel innerhalb des Gebaudes
verlegen.



Warnung: Ungeeignete Headsets, externe Lautsprecher oder Horer
kénnen zu Gehdrschaden fiihren oder die Sprachverbindung stéren.

* Beachten Sie die technischen Daten zum Anschluss eines Headsets.

Warnung: Durch das schwache Magnetfeld im Horer angezogene
Objekte wie Nadeln und Biroklammern kdnnen zu Verletzungen
fuhren.

* Legen Sie den Hdrer nicht in die Nahe solcher Objekte.

Qé) Warnung: Erstickungsgefahr. Das Gerat enthalt Kleinteile, die von
Q Kleinkindern verschluckt werden kénnen.

» Halten Sie das Gerat aul3erhalb der Reichweite von Kleinkindern

Wichtig: Das Gerat ist nicht dafuir ausgelegt und sollte daher nicht flr
lebenserhaltende Systeme und/oder Anwendungen innerhalb nuklearer
Einrichtungen eingesetzt werden. Einem Einsatz des Gerats fiir solche
Anwendungen muss zwingend eine auf den Einzelfall zugeschnittene
schriftliche Zustimmung/Erklarung des Herstellers vorausgehen.

Nicht bestimmungsgemafie Verwendung kann z. B. zu
Funktionseinschrankungen oder Stérungen, zur Zerstérung des Gerats oder
schlimmstenfalls zur Gefahrdung von Personen fuhren.

» Wenn Sie sich Uber die bestimmungsgemalfe Verwendung auch nach
dem Lesen des folgenden Kapitels nicht sicher sind, fragen Sie lhren
Fachhandler.

* Lesen Sie die zum Gerat gehérenden Anleitungen und bewahren Sie
diese zum spateren Gebrauch auf.

» FUr die Nutzung einiger Funktionen ist eine Freischaltung beim
Netzbetreiber, ein Firmware-Update und/oder eine Einrichtung uber
COMfortel Set notwendig.

BestimmungsgemiRe Verwendung

Systemtelefon zum Anschluss an den internen Sy- oder Upy-Port einer TK-
Anlage von Auerswald/FONtevo (siehe Technische Daten). Der Anschluss an
eine TK-Anlage eines anderen Herstellers oder an den externen SO-Anschluss
eines Netzbetreibers ist nicht vorgesehen. Das Telefon ist schnurgebunden
und fiir den Betrieb in geschlossenen, trockenen Raumen vorgesehen.

Technische Daten

Betriebsspannung Versorgung Uber internen Sy- oder Upy-Port aus
der TK-Anlage; mit COMfortel Xtension300:
Versorgung Uber Netzteil notwendig; 230 V ~; +/-

10 %, 50 Hz
Netzteil Typ-Nr. FW7577/EU/40
Leistungsaufnahme Min. 1,1 W, max. 1,9 W; COMfortel Xtension300:

+0,6 W



Systemanschluss

Interner Sp- oder Upg-Port der TK-Anlagen:
COMpact 3000 analog/ISDN/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R,

COMpact 5200/R, COMpact 5500R,
COMmander 6000/R/RX. COMmander Basic 2/
19", COMmander Business/19"

PC-/Datenschnittstelle

usB

Anzeigen

18 LEDs, 15 davon mehrfarbig, 4,3 Zoll-TFT-
Farbdisplay, 480 x 272 Pixel,
Hintergrundbeleuchtung

COMfortel Xtension300: 30 LEDs, mehrfarbig

Bedienelemente

Wahltastatur, 12 Festfunktionstasten, Farbdisplay
mit Touch-Funktion, Steuerkreuz, 15
programmierbare Funktionstasten mit LED (mit
jeweils bis zu zwei Funktionen auf zwei Ebenen
belegbar)

COMfortel Xtension300: 30 programmierbare
Funktionstasten

Horer Wideband Audio, Elektret-Mikrofon, dynamischer
Hérerlautsprecher, hérgeratekompatibel
Headset Separate Schnittstelle fiir schnurgebundene

Headsets, auch mit DHSG-Unterstlitzung

Gabelumschalter

Magnetischer Schaltkontakt

Gehause Kunststoff, schwarz, weifl}

Abmessungen 275 mm x 128/150/170 mm x 210 mm;

(BxHxT) COMfortel Xtension300: 120 mm x 68/90/110 mm
x 210 mm

Gewicht Ca. 1050 g; COMfortel Xtension300: ca. 310 g

Temperatur Betrieb: 0 bis 40 °C, Lagerung: - 30 bis + 70 °C,
nicht kondensierend

Sicherheit CE

Technische Daten fiir den Anschluss eines Headsets

Stromaufnahme Mikrofon Max. 0,5 mA
Empfindlichkeit Mikrofon -45dB

Impedanz Lautsprecher 150 Ohm
Empfindlichkeit Lautsprecher bei 1 kHz 19,5 +/- 3 dBPa/V
Schallpegelgrenze 24 dBPa




Umwelthinweise

Sollte das Geréat einmal ausgedient haben, achten Sie auf die fachgerechte
Entsorgung (nicht in den normalen Hausmdill).

&y Entsorgen Sie das Verpackungsmaterial im Interesse des
%9 Umweltschutzes ordnungsgeman.

Erkundigen Sie sich bei der Stadt- oder Gemeindeverwaltung nach
Méglichkeiten einer umwelt- und sachgerechten Entsorgung des Geréats.
Wenn Sie méchten, dass wir lhnen die Entsorgung abnehmen, senden
Sie das Gerat auf Ihre Kosten an die Auerswald GmbH & Co. KG.

Konformitétserklarung

Dieses Gerat entspricht den grundlegenden Gesundheits-, Sicherheits- und
Umweltanforderungen aller relevanten européischen Richtlinien. Die
Konformitatserklarung kann im Internet eingesehen werden.

Garantiebedingungen

1. Die Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, gewahrt als Hersteller auf
dieses Produkt 24 Monate Herstellergarantie ab Kaufdatum.

2. Dies bedeutet fiir Sie als Verbraucher: Wir garantieren, dass unsere Geréte bei der Ubergabe fehlerfrei sind und
sorgen 24 Monate ab diesem Datum fiir eine kostenlose Reparatur oder liefern kostenfrei Ersatz, falls ein
Herstellungsfehler auftritt und verzichten auf den durch Sie als Verbraucher zu fiihrenden Nachweis wie bei der
gesetzlichen Gewahrleistung, dass dieser Fehler zum Zeitpunkt der Ubergabe schon vorhanden war. Bei der
Reparatur oder der Ersatzlieferung verwenden wir entweder neue oder neuwertige Teile. Dem Gerat evtl.
entnommene Teile gehen in unser Eigentum iber und diirfen vernichtet werden.

3. Neben dieser Garantie stehen dem Kunden in vollem Umfang die gesetzlichen Rechte aus der
Mangelgewahrleistung auf der Grundlage des Kaufvertrages gegentiber dem Lieferanten zu. Die gesetzliche
Mangelgewahrleistung betrifft aber im Gegensatz zu unserer Herstellergarantie nur die Beschaffenheit zum Zeitpunkt
des Verkaufs (Ubergabe).

4. Sie kénnen diese Garantie nur in Anspruch nehmen, wenn Sie das fehlerhafte Gerat mit einem eindeutigen
Kaufbeleg (Rechnung oder Kassenbeleg) auf Ihre Kosten an die Auerswald GmbH & Co. KG bzw. auRerhalb
Deutschlands an unseren Generalimporteur oder Distributor vor Ort einsenden. Fiigen Sie dieser Einsendung bitte
eine ausfiihrliche Fehlerbeschreibung bei und geben Sie bitte auch fiir eventuelle Nachfragen Ihre Telefonnummer an.
Um Transportschaden zu vermeiden, sorgen Sie bitte fiir eine geeignete Transportverpackung (z. B.
Originalverpackung mit Umkarton).

5. Ausgeschlossen von der Herstellergarantie sind Schaden, die durch unsachgeméRe Behandlung,
Bedienungsfehler, Missbrauch, duRere Einflisse, Blitzschlag/Uberspannung, Veranderungen des Produkts sowie
Anbauten entstehen. Des Weiteren ausgeschlossen sind Verschleiteile (z. B. Batterien, Sicherungen, Akkus,
Speicherkarten), sowie durch VerschleiRteile entstandene Schaden (z. B. durch das Auslaufen von Batterien).
Ebenfalls ausgeschlossen sind Transportschaden, Folgeschaden, Kosten fiir Ausfall- und Wegezeiten.

6. Die Garantie erlischt bei Reparaturen durch nicht autorisierte Stellen.

Erstinbetriebnahme
SchlieRen Sie das Telefon wie in der Abbildung unter Anschluss gezeigt an.

Ersteinrichtung iiber das Telefon

Voraussetzungen:
» An der TK-Anlage eingerichtete interne Rufnummer
Folgen Sie den Anweisungen im Telefon.



Hinweis: Die MSN ist die in der TK-Anlage eingerichtete interne
Rufnummer.

Einrichtung liber COMfortel Set

Voraussetzungen:

+ Java Runtime installiert (finden Sie auf unserer Internetseite)

» COMfortel Set installiert (finden Sie auf unserer Internetseite)

» Bestehende Verbindung des PCs zum Telefon
— Uber eine PC-Schnittstelle der TK-Anlage (siehe Anleitung der TK-Anlage)
— Oder direkt (iber den USB-Anschluss des Telefons (*<=*)

Hinweis: Bei Nutzung des USB-Anschlusses muss auf dem PC zuerst der
USB-Treiber installiert werden (siehe Anleitung ,Erweiterte Informationen®).

1. Starten Sie das Programm.

2. Wabhlen Sie unter Optionen > Schnittstelle die von Ihnen verwendete
Schnittstelle aus (z. B. IP-Netzwerk bei Verbindung des PCs mit der TK-
Anlage Uber das lokale Netzwerk).

3. Klicken Sie auf Offnen > Telefon und wahlen Sie das betreffende Telefon
aus.

4. Geben Sie die PIN ein.
Nehmen Sie die gewlnschten Einstellungen vor.

6. Sichern Sie die Konfiguration anschlieflend in das Telefon. Klicken Sie
dazu nacheinander auf Datei > Speichern > Telefon.

o



English

Important Information

Safety Information
Warning: Handling the device improperly can cause a life-threatening
electrical shock, or damage or destroy the device.
» Read the manuals for the device and keep them for future reference.

» Only connect the device's connection cables to wall sockets that are
designed for that purpose, and that have been properly installed.

» Only use original accessories and original replacement parts.
Warning: Incomplete or incorrect configuration can create a personal
hazard e.g. because emergency calls cannot be made.

» The product is configured using the telephone or the COMfortel Set
software. The associated help is provided in English or German. If you are
not familiar with these languages, and the technical terms that are used,
seek support from someone who has the necessary technical and
language skills.

Warning: Using the wrong wall-mounted power supply can result in
life-threatening electrical shock, or damage or destroy the telephone.

« For this reason, only use a wall-mounted power supply of type no.

FW7577/EU/40.
Warning: Any liquid that penetrates the casing can result in a life-
threatening electric shock or can damage or destroy the telephone.

* Only operate the telephone in closed, dry rooms.

* Only clean the device with a soft damp cloth or an anti-static cloth.
Warning: Damaged connecting cables, or damage to the casing or
the device, can cause life-threatening electrical shocks.

» Never use a damaged device.

Warning: Power surges, which can occur during electrical storms,

can cause life-threatening electric shocks or damage/destroy the
device.

» Do not touch the device during an electrical storm.
« Arrange for a qualified electrician to install all the cables inside the building.
Warning: Non-approved headsets, external loudspeakers, or

receivers, may cause hearing damage or interfere with the voice
connection.

» Note the technical information about connecting a headset.

Warning: Objects attracted by the weak magnetic field in the receiver,
such as needles and paper clips, can cause injuries.



» To avoid injuries, do not put the receiver down close to such objects.

Warning: Danger of suffocation. The device contains small parts
Qi which infants or small children might swallow.

» Keep the device out of reach of children.

Important: The device is not designed or intended for use in life-support
systems and/or nuclear facilities. The device can only be used for these
purposes with prior written permission/clarification from the manufacturer in
each individual case.

Improper use may, for example, cause functional restrictions or
malfunctions, the destruction of the device or, in a worst case scenario,
personal injury.

If you are still uncertain about how to use the product properly after reading
the section below, please contact your specialised dealer.

* Read the manuals for the device and keep them for future reference.

« Some of the functions require activation by the network provider, a
firmware update and/or configuration via COMfortel Set.

Proper Use

System telephone for connection to the internal Sy or Upq port on a PBX
supplied by Auerswald/FONtevo (see Technical Data). There is no provision for
connecting to another manufacturer's PBX or to a network provider's external
Sy connection. The telephone is corded, and is intended for use in closed, dry
rooms.

Technical Data

Operating voltage |Power via the internal Sy or Upg port from the PBX.
With COMfortel Xtension300: Power provided via
wall-mounted power supply at 230 V ~; +/- 10 %,

50 Hz
Wall-mounted Type no. FW7577/EU/40
power supply
Power Min. 1.1 W, max. 1.9 W; COMfortel Xtension300:
consumption +0.6 W

System connection | Internal Sy port or Upg port from one of the following
PBXs: COMpact 3000 analog/ISDN/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

PC/data interface |USB




Displays 18 LEDs, 15 are polychromatic. 4.3" TFT colour
display, 480 x 272 pixels, backlight

COMfortel Xtension300: 30 LEDs, polychromatic
User elements Keypad, 12 permanently assigned function keys,
colour display with touch operation, directional pad,

15 programmable function keys with LED (on which
up to two functions can be assigned on two levels)

COMfortel Xtension300: 30 programmable function

keys

Receiver Wideband audio, electret microphone, dynamic
receiver loudspeaker, hearing aid compatible

Headset Separate interface for corded headsets, also with
DHSG (wireless headset) support

Hook key Magnetic switch contact

Casing Plastic material, black, white

Dimensions 275 mm x 128/150/170 mm x 210 mm;

(WxHxD) COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Weight Approx. 1050 g; COMfortel Xtension300: approx.
310g

Temperature Operation: 0 to 40 °C, storage: - 30 to + 70 °C, non-
condensing

Security CE

Technical Data for Headset Connections

Microphone current consumption Max. 0.5 mA
Microphone sensitivity -45dB
Loudspeaker impedance 150 Ohm
Loudspeaker sensitivity at 1 kHz 19.5 +/- 3 dBPa/V
Sound level threshold 24 dBPa

Environmental Notices

If you want to dispose of the device, please ensure its professional disposal.
Do not put it in the normal household waste.

&y Dispose of the packaging material properly and in interest of the
%9 environmental protection.

Consult your responsible authority for information about the professional
and environment-friendly disposal of your device. If you want that we
handle the disposal for you, you can send the device at your costs to
Auerswald GmbH & Co. KG.



Declaration of Conformity

This device complies with the basic health, safety and environmental
requirements in all relevant EU directives. You can view the Declaration of
Conformity on the Internet.

Conditions of Warranty

1. Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, grants 24 months Manufacturer's
Warranty from the date of purchase, as the manufacturer of this product.

2. For you, as a consumer, this means: We guarantee that our devices are error-free when supplied. If a manufacturing
error is identified within 24 months of the delivery date we will repair or replace the device free of charge without you,
as the consumer, having to provide the usual legally required proof that this fault was present when you received the
device. We either use new parts or parts in mint condition for the repair or replacement delivery. Any parts removed
from the device become our property and can be destroyed by us.

3. In addition to this warranty, you have the unlimited legal right to claim against the supplier on the basis of the terms
of the warranty for defects on the basis of the purchase contract. However, in contrast to our Manufacturer's Warranty,
the legal warranty for defects only applies to the device's state when sold (handover).

4. You can only claim against this warranty if you return the faulty device to Auerswald GmbH & Co. KG or our local
general importer or distributor, outside Germany, at your own cost, with a valid proof of purchase (invoice or till receipt).
When you return it to us, please provide a detailed description of the fault that has occurred, and also tell us your
telephone number, in case we need to contact you. To prevent shipping damage, provide suitable transport packaging
(e.g. original packaging with a secondary shipping box).

5. The Manufacturer's Warranty excludes damage caused by mishandling, operating errors, misuse, external
influences, lightning strikes/power surges, modifications to the product and extensions. Also excluded are wearing
parts (e.g. batteries, fuses, rechargeable batteries and memory cards) and damage caused by wearing parts (e.g. if
batteries go flat). Shipping damage, consequential damage, and costs arising from down times and travel times are
also excluded.

6. The warranty is cancelled if repairs are carried out by unauthorised agents.

Initial Commissioning
Connect the telephone as shown in the figure under Connection.

Initial Setup using the Telephone

Requirements:

* Internal telephone numbers configured on the PBX
Follow the instructions on the telephone.

Note: The MSN is the internal number that has been set up on the PBX.

Configuration via COMfortel Set

Requirements:

» Java Runtime is installed (available on our website)

» COMfortel Set is installed (available on our website)

+ Existing PC connection to telephone
— Using a PC interface on the PBX (see Instructions for the PBX)
— Or directly via the telephone’s USB connection (*<)

Note: When using the USB connection, the USB driver must first be installed
on the PC (see “Advanced Information” instructions).
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Run the program.

Select Options > Interface and then select the interface you are using (for
example, IP network, to connect the PC to the PBX over the local
network).

Click Open > Telephone and select the required telephone.
Enter the required PIN.
Configure the settings you want.

Now save the configuration in the telephone. Click File > Save >
Telephone.



Espanol

Informacién importante

Indicaciones de seguridad

Advertencia: Si este dispositivo se utiliza de forma indebida se corre
el riesgo de provocar una descarga eléctrica potencialmente mortal y
dafos en el dispositivo o su destruccion.

« Debe leer las instrucciones correspondientes al dispositivo y guardarlas.

» Los cables de conexion del dispositivo deben conectarse Unicamente a las
cajas de conexion instaladas especificamente para ellos

« Utilice exclusivamente repuestos y accesorios originales.

Advertencia: La configuracion incompleta o errénea del sistema
puede poner en riesgo a las personas, como en el caso de que no se
puedan realizar llamadas de emergencia.

+ La configuracion del producto se efectua a través del teléfono o del
software COMfortel Set. La ayuda correspondiente esta disponible en
inglés y en aleman. Si no tiene un dominio suficiente de estos idiomas ni
de la terminologia técnica solicite ayuda a un profesional técnico que
conozca dichos idiomas.

Advertencia: Si se utiliza un transformador de enchufe incorrecto se
corre el riesgo de provocar una descarga eléctrica potencialmente
mortal y dafios en el teléfono o su destruccion.

« Utilice solo el transformador de enchufe del modelo n.° FW7577/EU/40.

Advertencia: La penetracién de liquidos en el interior de la carcasa
puede provocar una descarga eléctrica potencialmente mortal y dafiar
o destruir el dispositivo.
 El teléfono solamente puede funcionar en espacios cerrados y secos.
» Para limpiar el dispositivo utilice Unicamente un pafio humedecido o un
pafio especial antiestatico.

Advertencia: Las lineas de conexion daiadas, asi como los dafios o
desperfectos en la carcasa o el propio dispositivo, pueden provocar
descargas eléctricas potencialmente mortales.
+ Jamas debe encender un dispositivo averiado o dafiado para hacerlo
funcionar.

Advertencia: Las sobretensiones, como las que pueden producirse
en caso de tormenta eléctrica, pueden provocar descargas eléctricas
potencialmente mortales y dafar o destruir el dispositivo.
* No toque el dispositivo durante una tormenta eléctrica.
« Debe encargar a un electricista el tendido de todos los cables en el interior
del edificio.



Advertencia: El uso de auriculares, altavoces externos o
microteléfonos inadecuados puede provocar dafios en el oido o
dificultar la comunicacion.

» Consulte los datos técnicos antes de conectar unos auriculares.

Advertencia: El campo magnético de baja intensidad del
microteléfono puede atraer objetos de oficina como chinchetas o clips
que pueden provocar lesiones.

* No deje el microteléfono cerca de dichos objetos.

Qé) Advertencia: Peligro de asfixia. Este dispositivo contiene piezas
Q pequenas que podrian ser ingeridas por nifios pequefios.
* Mantenga el dispositivo fuera del alcance de los nifios pequefios

Importante: Este dispositivo no se ha concebido para trabajar con sistemas
de soporte vital o aplicaciones relacionadas con instalaciones nucleares, por
lo que no se debe utilizar para tales fines. Si se pretende utilizar este
dispositivo para finalidades de esa naturaleza, es obligatorio contar con una
autorizacion o aprobacion previa por escrito del fabricante que se adapte a
las caracteristicas concretas del caso.

Utilizar este dispositivo para fines distintos de los previstos podria conllevar

limitaciones de su funcionamiento o averias y destruir el dispositivo o, en el

peor de los casos, comportar riesgos para la seguridad de las personas.

Si después de leer el siguiente capitulo le quedan dudas sobre el uso

adecuado y previsto del dispositivo consulte a su distribuidor especializado.

« Debe leer las instrucciones correspondientes al dispositivo y guardarlas
para poderlas consultar posteriormente.

» Para usar algunas funciones es preciso efectuar una activacion en el
operador de red, una actualizacién del firmware y/o ejecutar una
configuracion con el software COMfortel Set.

Uso previsto

Teléfono de sistema para conexion al puerto interno Sg 0 Upg de una centralita
de Auerswald/FONtevo (ver datos técnicos). No esta prevista la conexion a
una centralita de otro fabricante ni a la conexion externa Sy de un operador de
red. El teléfono con cable esta previsto para funcionar en espacios cerrados y
Secos.

Datos técnicos

Tension de Alimentacion a través de puerto interno Sy 0 Upg de
servicio la centralita; con COMfortel Xtension300: Es
necesaria una alimentacion a través de un
transformador de enchufe; 230V ~; +/- 10 %, 50 Hz

Transformador de | Modelo n.° FW7577/EU/40
enchufe

Potencia Min. 1,1 W, max. 1,9 W; COMfortel Xtension300:
absorbida +0,6 W




Conexion del
sistema

Puerto interno Sy o Upg de las centralitas:

COMpact 3000 analégica/RDSI/VolP,

COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/R,
COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Interfaz de datos/
PC

uUsSB

Indicadores

18 LED, 15 de ellos de varios colores, pantalla a color
TFT de 4,3 pulgadas, 480 x 272 pixeles,
retroiluminacion

COMfortel Xtension300: 30 LED de varios colores

Elementos de
mando

Teclado de marcado, 12 teclas con funciones fijas,
pantalla a color con funcion tactil, pad de control,
15 teclas de funcion programables con LED (se les
puede asignar hasta dos funciones a cada una en
dos niveles)

COMfortel Xtension300: 30 teclas de funcién
programables

Microteléfono

Audio de banda ancha, micréfono electret, altavoces
dinamicos, compatible con audifonos

Auriculares Interfaz independiente para auriculares con cable,
también con compatibilidad DHSG

Gancho Contacto de maniobra magnético

conmutador

Carcasa Plastico, negro, blanco

Dimensiones

275 mm x 128/150/170 mm x 210 mm;

(an x al x f) COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Peso Aprox. 1050 g; COMfortel Xtension300: aprox. 310 g

Temperatura Funcionamiento: De 0 a 40 °C, almacenamiento: De
-30a + 70 °C, sin condensacion

Seguridad CE

Datos técnicos para la conexion de auriculares

Consumo de potencia micréfono Max. 0,5 mA
Sensibilidad micréfono -45dB
Impedancia altavoz 150 ohmios
Sensibilidad altavoz a 1 kHz 19,5 +/- 3 dBPa/V

Limite de nivel sonoro 24 dBPa



Indicaciones relativas al medio ambiente

Si el dispositivo se queda anticuado o finaliza su cometido, debe tener en
cuenta las normas especificas para la eliminacion del mismo (no se debe
desechar junto con la basura doméstica).

&y Elimine el material de embalaje conforme a las normas de proteccion del
%9 medio ambiente.

Consulte al 6rgano de administracion municipal cuales son las

posibilidades para desechar el dispositivo de una forma adecuada y

respetuosa con el medio ambiente. Si lo desea, nosotros podemos
hacernos cargo de la eliminacion. En tal caso, envie el dispositivo a Auerswald
GmbH & Co KG. Debera correr con los gastos de envio pertinentes.

Declaracion de conformidad

Este dispositivo cumple con los requisitos esenciales sobre salud, seguridad y
medio ambiente de todas las directivas europeas pertinentes. La declaracién
de conformidad se puede consultar en Internet.

Condiciones de la garantia

1. La empresa Auerswald GmbH & Co. KG, con sede en Vor den Grashéfen 1, 38162 Cremlingen, Germany, como
fabricante de este producto, ofrece una garantia de fabricante por un plazo de 24 meses, contados desde la fecha de
compra.

2. Para usted, como consumidor, esto implica que: Le garantizamos que nuestros dispositivos estan en perfecto
estado de funcionamiento en el momento de la entrega. Durante un plazo de 24 meses a partir de esa fecha, en caso
de defectos de fabricacion, le proporcionaremos un servicio de reparacion totalmente gratuito o le facilitaremos un
aparato de sustitucion sin coste. A diferencia de las condiciones de la garantia legal obligatoria, usted no tendra que
demostrar que el problema o la averia ya existia en el momento de la entrega de la centralita. En caso de que sea
preciso realizar reparaciones o entregarle un dispositivo de sustitucion, utilizaremos componentes nuevos o en
perfecto estado. Los componentes que pudieran extraerse del dispositivo pasaran a ser de nuestra propiedad,
estando permitida su destruccién.

3. Ademas de esta garantia, el cliente cuenta con todos los derechos legales derivados de la garantia contra defectos
impuesta por ley, que descansan sobre el contrato de compraventa y cuyas responsabilidades recaen sobre el
proveedor. A diferencia de nuestra garantia de fabricante, la garantia legal contra defectos solamente cubre las
condiciones del producto en el momento de la venta (entrega).

4. Solamente podra efectuar reclamaciones al amparo de esta garantia si acompafia el dispositivo defectuoso de un
documento que acredite con claridad la adquisicién (factura o recibo de compra), que debe presentar corriendo usted
con los correspondientes gastos ante Auerswald GmbH & Co. KG o, en caso de encontrarse fuera de Alemania, ante
nuestro importador general o distribuidor local. Le rogamos que, junto con el dispositivo y la documentacién
acreditativa de la compra, incluya una descripcion detallada del problema y nos facilite asimismo un nimero de
teléfono para poder plantearle las preguntas que pudiesen surgir. Para evitar que el dispositivo sufra dafios durante
el transporte, le aconsejamos que procure emplear un embalaje apropiado para ello (por ejemplo, el embalaje original
dentro de una caja protectora).

5. Quedan excluidos de la garantia del fabricante los dafios causados por manipulacion inadecuada, errores de
manejo, usos indebidos, factores externos, sobretensiones o impactos de rayos, alteraciones del producto o
accesorios complementarios incorporados. Quedan asimismo excluidos de la garantia los componentes sometidos a
desgaste (por ejemplo: pilas, fusibles, baterias, tarjetas de memoria) y los dafios provocados por componentes
sometidos a desgaste (por ejemplo, por pilas agotadas). También quedan excluidos de la garantia los dafios ocurridos
durante el transporte, los dafios indirectos y los costes por interrupciones del servicio y tiempos de los traslados.

6. La garantia se considerara extinguida si se efecttan reparaciones en talleres no autorizados.

Entrada en servicio

Realice las conexiones del teléfono como se muestra en la figura titulada
"Conexion".



Configuracion inicial a través del teléfono
Requisitos:

» Numero interno configurado en la centralita
Siga las instrucciones del teléfono.

Nota: EI MSN es el numero interno configurado en la centralita.

Configuracién a través COMfortel Set

Requisitos:

+ Java Runtime instalado (lo encontrara en nuestra pagina web)
+ COMfortel Set instalado (lo encontrara en nuestra pagina web)
+ Conexion establecida entre el PC y el teléfono

— Através de una interfaz PC de la centralita (véanse las instrucciones de la
centralita)

— O directamente a través de la conexién USB del teléfono (~<=*)

Nota: Si se utiliza la conexién USB, primero se debera instalar en el PC el
controlador USB (véanse las instrucciones "Advanced Information").

—_

Inicie el programa.

2. En Opciones > Interfaz seleccione la interfaz que utiliza (p. ej. Red IP
para la conexién del PC con la centralita a través de la red local).

3. Haga clic en Abrir > Teléfono y seleccione el teléfono que corresponda.

4. Introduzca el PIN.

5. Realice los ajustes deseados.

6. Acto seguido guarde la configuracion en el teléfono. Para ello haga clic

sucesivamente en Fichero > Guardar > Teléfono.



EAANnvVIKaA

ZNMAVTIKEG TTANPOPOPIES

Ymodeifeig acpaleiag

Mpogidotroinon: H akatdAANAn xprion TNG CUCKEUNG UTTOPET va
odnynoel g Bavatneopo NAEKTPOTTANEia Kai va TTPOKAAETEl CnUIES i
Va KOTOOTPEWEI TN CUOKEUN.

» AloBdoTe TIG 00nyieg XpAONG TTOU CUVOBEUOUV TN GUCKEUT KOl QUAGETE TIG.

* 2uvOéeTe TO KAAWDIO OUVOEONG TNG CUOKEUNG HOVO OTIG OXETIKA
TIPORAETTOUEVEG KAl CWOTA TOTTOBETNUEVEG TTPICES
+ XpNOIYOTIOIEITE ATTOKAEIOTIKA YV OIA EEAPTHPATA KAI AVTOAAGKTIKA.

Mpoeidotroinon: H eANITTG | ecpaApévn pUuBuion evdéxeTal va BEoel
o€ KivOuvo Atopa, TT. X. AOyw Hn €KTEAECIUWY KANOEWVY EKTAKTNG
avAaykng.

* H puBpion Tou TTPOIGVTOG TTPAYHATOTTOIEITAI HECW TOU TNAEPWVOU 1 HECW
Tou Aoyiopikou COMfortel Set. H oxeTikr) BoriBeia diatiBeTal otnv ayyAikn
1| TN yepUavikr YAWooa. Av Ogv €i0TeE £EOIKEIWPEVOI UE QUTEG TIG YAWOOEG
KalI TOUG XPNOIKOTTOIOUPEVOUG €18IKOUG OPOUG, CUMPBOUAEUTEITE TEXVIKG Kal
YAwooIkd KatdAANAo €EEIBIKEUUEVO TTPOOWTTIKO.

Mpogidotroinon: H xprion e0@aApévou TPOPOdOTIKOU UTTOPEI va

odnynoel e Bavatn@opo NAeKTPOTTANEia Kal va TTPOKAAETEl CnUIES i
Va KATOOTPEWE TO TNAEPWVO.

» XpnoigotroifoTte pévo 1o TpoPodoTIKS ap. Tutou FW7577/EU/40.
Mpoeidotroinon: H cioxwpnon uypwv a1o TTEPIBANUA UTTOPET va
odnynoel o€ Bavatnedpo NAEKTPOTTANSIa Kal va TTPOKaAEéTEl {NUIEG N
VQ KATAOTPEWEI TN OUOKEUN.

* Aeitoupyeite T0 TNAEPWVO POVo g€ KAEIOTOUG, ENpoUg XWPOoug.

» KaBapilete TN cuoKeur HOVO PE EAAPPWGS BPEYUEVO TTAVI 1] JE AVTIOTATIKO

TTavi.

Mposidotroinon: Kareatpapuéva KaAwdia, Kabwg kai {nuIEG aTo
ePiBANUa kai Tnv idia TN CUOKEUr PTTOPOUV va 0dnNyrjoouV O€
Bavatneopo nAekTpotTAngia.

* Mnv B€1€TE O€ AcITOUPYIQ IO KATESTPAUUEVN CUOKEUN.
MNposidotroinon: O utrepTdoelg TTou cupBaivouv katd Tn didpKela

KaTalyidwv YTTopouv va TTPOoKaAEaouv Bavatn@opo NAEKTPOTTANEia Kal
va TTPOKAAEOOUV CNUIEG ] VO KATAOTPEWOUV Tr CUCKEUT).

o ATToQeUyeTe KOTA TN SIAPKEIN KATAIYiIOWY TNV ETTAPNA UE TN OCUCKEUN.

» AvabéoTe o€ €vav e£eIdIKeEUPEVO NAEKTPOAOYO va TOTTOBETOEI OAa TO
KaAwdla evTOG TOU KTIpiou.



Mpogidotroinon: AKatdAANAa COET AKOUCTIKWY, EEWTEPIKA nxeia
AKOUCOTIKG PTTopouV va odnyroouv o€ BAGREG oTnv akon r va
TIPOKAAECOUV TTAPEPPBOAEG OTN OUVOEDN CUVOMIAICG.

* Tnpeite Ta TEXVIKA OTOIXEIQ YIO TN OUVOECN OET OKOUCTIKWV.

Mpo&idotroinon: Adyw Tou acBevoUg payvnTikou Tediou 010
QKOUCTIKO TG QVTIKEIMEVA TTOU TTPOCEAKUOVTAI, OTTWG BEAGVEG Kal
OUVOETAPEG, NTTOPOUV VA 0BNYROOUV G€ TPAUPATIGHOUG.

* Mnv TOTTOBETEITE TO OKOUOTIKO KOVTA O€ TETOIOU E£iBOUG AVTIKEIPEVA.

Qé) Mposidotroinon: Kivduvog acguéiag. H ouakeur repiéxel HIKpa
Q KOUPATIa pe Kivouvo KATatroong atro Hikpd TTaidid.
» QuAAOOETE TN OUOKEUN PAKPIG AT PIKPA TTaIdId

InMavTikG: H ouakeur) Oev £xel oxedIaOTEl Kal OV TTPETTEI ETTOUEVWG VA
XPNOILOTIOIEITOI O€ TUOTAPATA /KAl EQAPUOYEG UTTOOTAPIENG JWTIKWV
AgITOUPYIWV péoa O€ TTUPNVIKEG EyKATAOTAOEIG. [pIv atrd Tn XxpHon Tng
OUOKEUNG O€ TETOIEG EQAPUOYEG Ba TTPETTEI VO TTPONYEITAI UTTOXPEWTIKA HIA
TIPOCAPHOCUEVN OTN CUYKEKPIKEVN TTEPITITWON £yypagn ouykaTdbeon/
OAAwWON TOU KOTAOKEUQOTH).

H pn poBAerdpevn xpAon UTTopei va odnyroel, TT. X. O€ AEIToupyIkoUg

TTEPIOPIOUOUG 1) DIATAPAXES, ATNV KATAGTPO®NA TNG CUCKEUNG ) OTN XEIPOTEPN

TTEPITITWON GTOV TPAUMATICHO ATOHWV.

+ Av d¢ev gioTe BEBaior yia TNV TTPOBAETTOPEVN XPAON OKOPA KAl HETA TV
avAayvwan ToU ETTOPEVOU KEQAAQIOU, pwWTHOTE TOV ECEIDIKEUUEVO EUTTOPO
oag.

» AloBdoTe TIG 00nyieg xpAONG TTOU CUVOBEUOUV TN GUOKEUN KOl QUAGETE TIG

yia JeAAOVTIKA Xprion.

» [0 TN Xprion opIouéVWY AEITOUPYIWVY ATTAITEITAI EVEPYOTTOINGN OTOV POpPEQ

EKUETAANAEUONG, EVNUEPWOT UAIKOAOYIOUIKOU r)/kal pUBUION HETW TOU
COMfortel Set.

MpoBAemropevn xpnon

TnAépwvo ouoTAPATOG YIa OUVOEDT OTNV ECWTEPIKN) BUpa Sy ) BUpa Upq £vOg

TNAE@WVIKOU kévtpou Tng Auerswald/FONtevo (BAETTE TEXVIKG OTOIXEIQ). Agv
TTPORAETTETON N OUVOEDN O€ £va TNAEQPWVIKO KEVTPO KATTOIOU GAAOU
KOTAOKEUAOTN 1 OTNV £§wTEPIKA oUvOEDn Sy evOG Popéa eKPETAAEUONG. To

TNAEPWVO gival eEveUPUATO Kal TTPoopideTal yia AeIToupyia o€ KAEIoTOUG, Enpolg

XWPOUG.

Texvikd oToIxeia

Tdon Aeitoupyiag | Tpopodooia péow eowTepIKng BUpag Sy 1 Upg attod
TO TNAEPWVIKS KEVTPO, e COMfortel Xtension300:
Tpogodoaia atmrapaitnTa HEoW TPoYodoTikou, 230 V
~, +/- 10 %, 50 Hz

Tpo@odoTikd Ap. TUTTOU FW7577/EU/40



KaravaAwon EAdy. 1,1 W, péy. 1,9 W, COMfortel Xtension300:

10x00¢g +0,6 W

2uvdeon EowTepikr) BUpa Sy UpgTwVv TNAEQWVIKWYV KEVTPWV:

OUGTAUOTOG COMpact 3000 avaAoyiké/ISDN/VolP,
COMpact 2206 USB, COMpact 4410 USB,
COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Oupeg USB

utroAoyiaTr/

dedopévwv

[MpoBoAn 18 Auyvieg LED, 15 amrd auTég TTOAUXPWEG,

£yxpwpn 06évn 4,3 ivicwv TFT, 480 x 272 pixel,
PWTIOPOG POVTOU

COMfortel Xtension300: 30 Auxvieg LED,
TTOAUXPWUES

ZTOIXEIO XEIPIOUOU

MANkTPOAdYIO £TTIAOYNG apIBuwWY, 12 TTARKTPa
oTaBepng Asitoupyiag, £yxpwun 086vn pe Asitoupyia
ang, TTANKTPOAGYIO KAang, 15 TTpoypauuaTifoueva
TAAKTPa Asimoupyiag pe Auxvia LED (duvatotnra
QVTIOTOIXIONG €WG Kal dU0 AsiToupyieg o€ dUO
eTiTTedQ)

COMfortel Xtension300: 30 TTpoypappaTifOpEva
TIANKTPa AgiToupyiag

AKOUOTIKO

Wideband audio, pikpoé@wvo Elektret, duvauikd nxeio
OKOUGTIKOU, CUMPBATO PE OKOUTTIKEG CUOKEUEG

2 €T OKOUOTIKWV

ZeXWPIOTEG BUPEG yIa EVOUPUATA OET AKOUCTIKWY, KAl
ME UTTOOTHPIEN ACUPPATWY OKOUCTIKWY UE
Mikpdpwvo (DHSG)

Al0KOTITNG MayvnTikr) eTTa@r dIaKOTITN

aykioTpou

MepiBAnua MAQOTIKO, Haupo, Aeukd

AlaoTdoeig 275 mm x 128/150/170 mm x 210 mm;

(MxYxB) COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Bdapog Mep. 1050 g, COMfortel Xtension300: Mep. 310 g

O¢puokpacia Aeiroupyia: 0 £éwg 40 °C, ammoBrkeuon: - 30 £wg

70 °C, xwpig guutrukvwon

AopaAeia

CE



TexvikG oTOIXEiA YIO T OUVSEOT EVOG OET OKOUCTIKWV

KaravaAwan 1ox00G HIKPOPWVOoU Méy. 0,5 mA
EvaioBnaoia pikpoguwvou -45dB
AvrtioTaon nxeiou 150 Ohm
Euvaiobnaoia nxeiou o€ 1 kHz 19,5 +/- 3 dBPa/V
Opia o1dOuNG Xou 24 dBPa

MepiBaAAovTikég uTTOSEISEIG

Z¢& TTEPITITWON TTOU N CUOKEUN CUPTTANPWGEl TNV weENiun didpkeia {wAG TG,
@povTIoTE yia TNV KATAAANAN atmoppiwn (Ox1 yadi e Ta guvron OIKIaKA
atroppippaTa).

&y AtroppiyTe To UANIKG OUOKEUOCIOG OWOTd, PPOVTICOVTOS Yia ThV

%& TTpooTaCia Tou TTEPIBAAAOVTOG.

MAnpogopnBeite atrd Tn dnUOTIKN A TOTTIKF apxXn yia TIg duvaTdTnNTEG
OwaOTAG Kal GIAIKAG TTPOG TO TTEPIBAAAOV aTTéPPIWNG TNG OUCKEUNG. Av
B¢éAeTe va avalaBoupe eEiG TNV aTTOPPIYN, OTEIATE TN CUOKEUN 0OG HE
OIkr) oag emidapuvon otnv Auerswald GmbH & Co. KG.

ARAwon cuppudépPwong

AUTA N CUCKEUN CUUHOPQWVETAI HE TIG BATIKEG ATTAITATEIG UYEIAG, aopaAciag
KaI TTEPIBAAAOVTOG OAWV TWV OXETIKWYV EUPWTTAIKWY 0dnyIwv. MTTopeite va
Ocite TN dSAWGON CUUUOPPWONG OTO BIAdIKTUO.

Opol Tapoxrig eyyonong

1. H Auerswald GmbH & Co. KG, Vor den Grashdéfen 1, 38162 Cremlingen, Germany, TTapéxel WG KATAOKEUAOTAG
auToU TOU TTPOIGVTOG £yyUNON KATAOKEUAOTH 24 unvwy aTré TNV nuepounvia ayopdg.

2. MNa €046 wg KatavaAwTh auté onpaivel: EyyudpaoTe 0TI 0l GUOKEUEG pag gival atraAAaypéveg aTTd o@daApara kaTd
TNV TTapadoon kai e§ac@aiifoupe 24 Pveg atmd AUTAV TNV NUEPOUNVia dwPEGV ETTIOKEUR 1) SwPEAV avTIkaTdoTaaon, o€
TIEPITITWON GQAAUATOG KATAOKEUNG Kal TTapaiTOUPACTE ATTO TO OTTODEIKTIKG TTOU TTIPETTEI VO UTTOBANBET aTTd £0GG WG
KaTavaAwTr), UPGWVa PE T VOMIUN €yyUnon, OXETIKA PE TO 6T auTé To OQAAa UTTAPXE BN TO XPOVIKG onueio TNg
Tapdadoong. Katd Ty €1MOKEUN 1) TNV TTapAadoon TG avTIKATAOTAONG XPNOIUOTIOIOUNE EiTE KAIVOUPYIa EiTE
avokaTaoKeuaopéva pépn. Ta pépn mmou evaexopévwg Ba agaipeBolv atd Tn CUCKEUN TTEPVOUV OTNV IBIOKTNCIC HOG
Kal ETTPETTETAI VO KOTAGTPAPOUV.

3. EKk16G 0116 TNV Trapoloa £yyunan o TEAGTNG dikaioUTal TTARPWS Ta VOHING SIKAIWUATA, OTTWG TTPOKUTITOUV atrd TV
eyyunon Tepi eAaTTwPaTWY Baoel TNG oUPPBAoNg ayopdg atrévavTi oTov TTpounBeuTh. H vopiun eyydnon trepi
EAATTWHATWY aPopd WOTOCO OE AVTIBEDN PE TN BIK PAG £yyUNON KATAOKEUAOTH HOVO TNV KATAGTAGN KATA TO XPOVIKO
onpeio Tng TWANonNg (TTapddoon).

4. MTropeiTe va eTw@eANBEiTE TNG TTAPOUCAG EYyUNONG HOVO av OTEIAETE TNV EAQTTWHATIKA CUOKEUN Padi JE HIa oor
atédeign ayopdg (TiHoAdyIo 1 amddeign) pe dikd oag £§oda oTnv Auerswald GmbH & Co. KG 1 ek1d¢ leppaviag ot
OIKO HOG YEVIKO EI0QYWYEA 1) TOTTIKO Slavopéa. TNV aTToOTOAR GUUTTEPIAGBETE AETITOUEPH TTEPIYPAPH TOU OPAAPATOG
Kal OnAWOTE Kal ToV apIBPG TNAEPWVOU 0aG Yia EVOEXOUEVES TTEPAITEPW EPWTATEIG. INa va atTroQUYETE NUIEG KATG TN
HETAQOPA, XPNOIUOTTOINOTE KATAAANAN GUOKEUATia HETAPOPAS (TT. X. N APXIKF) CUOKEUAOIa Hadi HE EEWTEPIKS XaPTOVI).
5. A6 tnv gyyUnaon KaraokeuaoTr| egaipouvTal ol nUIEG TTou TTPoKaAoUVTal atrd akaTAAANAC XEIpIoPS, TQAApaTa
XEIPIOHOU, ECQAAPEVN XPNON, ESWTEPIKEG ETTIPPOEG, AOTPATTEG/UTTEPTACTT, HETATPOTTEG OTO TIPOIOV, KABWG Kal
etmekTdoelg. EmTAéov, e€aipolvTal Ta e§apTipaTa @Bopdg (Tr. X. HTTATAPIEG, AOPAAEIEG, TUTTWPEUTEG, KAPTEG
atmoBAKeUaNG), KABWG Kai o1 {NUIEG TToU TTPOoKaAoUVTaI aTré £€apTAHATA POOPAEG (TT.X. AdYyw dIAPPONG TWV PTTATAPIWV).
Emiong, e§aipolvTal o1 nUIEG KATA TN YETAPOPA, OI ETTAKOAOUBEG {NMIEG, Ta KOOTN ACTOXIWV KAl TV SIACTNHAETWY
HETAKIVATEWV.

6. H gyyUnon mradel va 1ox0el 6TAV Ol ETTIOKEUEG EKTEAOUVTAI ATTO W £E0UCIOdOTNHEVA GTOUA.



MpwTtn 0éon o€ AsiToupyia
2uvdéoTe To TNAEQWVO, OTTWG EPPAVICETAI TNV EIKOVA Yia TH oUVOEDN.

ApXIKN pUBUION HECW TOU THAEQPWVOU

MpoUTtobéasig:

* 2TOV EOWTEPIKO aPIBPO KANONG TTOU £X€l pUBUIOTEI OTO TNAEPWVIKO KEVTPO
AkoAouBnaTE TIG 00NYiEG XPNOEIG OTO TNAEPWVO.

Ymodei§n: To MSN eival o ecwTePIKOG aplBUdg KARGNG TTou £XEl pUBUICTEI
OTO TNAEQWVIKO KEVTPO.

PUBuion péow Tou COMfortel Set
MpoUTtrobéosig:
» To Java Runtime éxel eykataoTaBei (BA. OXETIKG GTOV IGTOTOTTO PAG)
+ To COMfortel Set éxel eykataoTaBei (BA. OXETIKG OTOV IOTOTOTTO AG)
* Ymépxouoa ocUvdeon UTTOAOYIOTH OTO TNAEQWVO
— Méow piag BUpag utToAoyIoTr) Tou TNRAEQPWVIKOU KEVTPOU (BA. odnyieg
XPAONG TOU TNAEQWVIKOU KEVTPOU)
— 'H ameubtiag yéow piag ouvdeong USB Tou TnAepuwivou (*<=)

Ymwodei§n: Na mn xprion Tng olvdeong USB trpéTrel TTpwTa va £XEl
eykataoTabei To Tpdypapua odriynong USB aTov uttoAoyiaTh (BA. odnyieg
"Advanced Information").

1. EkkivnoTe TO TTPOYPAMA.

2. EmA&CTe aTo ETTIAOYEG> AlaoUvSEoN TIG XPNOIUOTTOIOUNEVES ATTO £GAG
BUpeg (11. X. AikTuo IP KOTG TN GUVOECN TOU UTTOAOYIOTH OTO TNAEPWVIKO
KEVTPO PEOW TOU TOTTIKOU BIKTUOU).

3. Kavre kAik atn diadpour) Avoiypa> TnAé@wvo Kai ETTIAECTE TO OXETIKO
TNAEQWVO.

4. KartayxwpioTte 10 PIN.

MpaypaToTroIRoTe TIG €MBOUUNTEG PUBUICEIS.

6. BePaiwbeite oTn ouvExela, yia Tn diapudpewaon, oTo TNAEPWVo. MNaTthoTe
Tpog ToUuTo dladoxikd oto Apxeio> Atrolnkeuon> TnAépwvo.

o



Francais

Informations importantes

Consignes de sécurité

Avertissement: Une utilisation non conforme de I'appareil peut
entrainer une électrocution mortelle et endommager ou détruire
I'appareil.
» Veuillez lire avec attention les notices se rapportant a I'appareil et les
conserver.

» Connectez le cable de raccordement de 'appareil uniquement aux boites
de jonction correctement installées et prévues a cet effet.

+ Utilisez exclusivement des accessoires et pieces de rechange d’origine.

Avertissement: Une installation incompléete ou défectueuse peut
entrainer des risques de blessures, par ex. en raison d’'un
dysfonctionnement des appels d'urgence.

+ La configuration du produit se fait par le téléphone ou par le kit logiciel
COMfortel. L’aide correspondante est disponible en anglais ou en
allemand. Si vous ne maitrisez pas ces langues et si la terminologie ne
vous est pas familiére, faites-vous assister par un professionnel spécialisé
et comprenant ces langues.

Avertissement: L'utilisation d’'un mauvais bloc d’alimentation peut
entrainer une électrocution mortelle et endommager ou détruire le
téléphone.

» N'utilisez que le bloc d’alimentation de type n°® FW7577/EU/40.
Avertissement: La pénétration de liquides dans le boitier peut
entrainer une électrocution mortelle et endommager ou détruire
I'appareil.

» N'utilisez le téléphone que dans des pieces fermées et séches.

» Nettoyez I'appareil avec un chiffon Iégérement humide ou un chiffon

antistatique uniquement.

Avertissement: Des lignes de raccordement endommagées ainsi
que des dommages au niveau du boitier et sur I'appareil peuvent
entrainer une électrocution mortelle.

» Ne faites pas fonctionner d’appareil endommagé.
Avertissement: Des surtensions, telles que celles survenant lors

d’un orage, peuvent entrainer une électrocution mortelle et
endommager ou détruire I'appareil.

* Lors d'un orage, ne touchez pas I'appareil.

* Tous les cables dans les batiments ne doivent étre posés que par un
électricien qualifié.



Avertissement: L'utilisation de micro-casques, de haut-parleurs ou
écouteurs externes non adaptés peut entrainer une perte auditive ou
dégrader la qualité de la conversation.

» Pour connecter un micro-casque, respectez les spécifications techniques.

Avertissement: En raison du faible champ magnétique dans
I'écouteur, des objets attirés par I'aimant, comme des aiguilles ou des
trombones, peuvent entrainer des blessures.

* Ne posez pas I'écouteur a proximité de tels objets.

Qé) Avertissement: Danger d’étouffement. L’appareil contient des petites
Q piéces susceptibles d’étre avalées par des enfants en bas age.

« Tenez I'appareil hors de la portée des jeunes enfants.

Important: L’appareil n'est pas prévu pour des systémes de survie et/ou
pour des utilisations dans des installations nucléaires et ne doit donc pas étre
utilisé dans ces conditions. Une utilisation de I'appareil dans de telles
conditions doit obligatoirement faire 'objet d’'une autorisation individuelle
spécifique écrite du fabricant.

Une utilisation non conforme peut par ex. entrainer une limitation des

fonctions ou bien des dysfonctionnements, la destruction de I'appareil ou,

dans les cas les plus graves, la mise en danger de personnes.

+ Si, malgré avoir lu le chapitre suivant, vous avez des doutes quant a
I'utilisation conforme, veuillez vous adresser a votre revendeur.

» Veuillez lire avec attention les notices se rapportant a I'appareil et les
conserver pour une utilisation ultérieure.

» Pour I'utilisation de certaines fonctions, une activation par I'exploitant du
réseau, une mise a jour de la version du logiciel et/ou une configuration
sont nécessaires.

Utilisation conforme

Téléphone pour connexion au port interne Sy ou Upg d’un systéme de
télécommunication Auerswald/FONtevo (cf. spécifications techniques). Le
raccordement a un systéme de télécommunication d’'un autre fabricant ou a la
prise externe Sy d’un exploitant de réseau n’est pas prévu. Le téléphone filaire
et congu pour une utilisation dans des piéces fermées et seches.

Spécifications techniques

Tension en Alimentation par port interne Sy ou Upg du systéme
fonctionnement de télécommunication, avec

COMfortel Xtension300 : alimentation par bloc
d’alimentation nécessaire ; 230V ~ ; +/- 10 %, 50 Hz

Bloc d’alimentation | type n° FW7577/EU/40

Puissance 1,1 W min., 1,9 W max. ; COMfortel Xtension300 :
absorbée +0,6 W




Raccordement au
systeme

Port interne Sy ou Upg du systeme de
télécommunication : COMpact 3000 analogique/
ISDN/VolP, COMpact 2206 USB, COMpact 4410
USB, COMpact 5010 VolP, COMpact 5020 VolP,
COMpact 4000, COMpact 5000/R, COMpact 5200/
R, COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Interface PC/

uUsSB

données

Affichages 18 LED, dont 15 multicolores, écran couleur TFT
4,3”, 480 x 272 pixels, rétro-éclairage
COMfortel Xtension300 : 30 LED, multicolores

Eléments de Clavier téléphonique, 12 boutons a fonction fixe,

commande écran couleur avec fonction tactile, croix
directionnelle, 15 boutons a fonction programmable
avec LED (avec chacune deux fonctions a affecter
sur deux niveaux)
COMfortel Xtension300 : 30 boutons fonctionnels
programmables

Ecouteur Audio a large bande, microphone a électret, haut-

parleur écouteur dynamique, compatible avec
appareils auditifs

Micro-casque

Interface séparée pour micro-casques filaires,
également compatibles DHSG

Crochet Commutateur de contact magnétique

commutateur

Boitier Plastique, noir, blanc

Dimensions 275 mm x 128/150/170 mm x 210 mm;

(Ixhxp) COMfortel Xtension300 : 120 mm x 68/90/110 mm x
210 mm

Poids env. 1 050 g ; COMfortel Xtension300 : env. 310 g

Température Fonctionnement : 0 a 40 °C, entreposage : - 30 a
+ 70 °C, sans condensation

Sécurité CE

Spécifications techniques pour la connexion d’un micro-casque

Alimentation microphone 0,5 mA max.
Sensibilité microphone -45dB
Impédance haut-parleur 150 Ohm
Sensibilité haut-parleur pour 1 kHz 19,5 +/- 3 dBPa/V
Limite du niveau sonore 24 dBPa




Consignes relatives a I’environnement

Si I'appareil n'est plus utilisé, veuillez vous assurer qu’il est mis au rebut de
maniére appropriée (et n’est pas jeté avec les ordures ménageres).

&Y. Veuillez jeter ou recycler 'emballage dans le respect de I'environnement.

Renseignez-vous auprés de votre ville ou commune pour savoir quelles

sont les possibilités de recyclage et de gestion des déchets pouvant

s’appliquer a I'appareil. Si vous souhaitez que nous nous chargions de la
gestion des déchets liés a I'appareil, envoyez I'appareil a vos frais a Auerswald
GmbH & Co. KG.

Déclaration de conformité

Cet appareil répond aux exigences relatives a la santé, la sécurité et
I'environnement de toutes les directives européennes en vigueur. La
déclaration de conformité peut étre consultée sur Internet.

Conditions de garantie

1. La société Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, accorde une garantie
fabricant sur ce produit, pour une durée de 24 mois suivant la date d’achat.

2. Pour vous en tant que client, ceci signifie que : nous garantissons que nos appareils sont irréprochables en I'état a
la livraison et que nous nous engageons, pour une période de 24 mois suivant cette date, a effectuer une réparation
ou a livrer une piece de rechange sans codts supplémentaires dans le cas ou un défaut de fabrication serait constaté,
et que nous renongons a exiger de vous, en qualité de client, la présentation d’une preuve de présence du défaut a la
livraison comme ceci est généralement le cas dans le respect de la garantie Iégale. Lors de la réparation ou de la
livraison de la piéce de rechange, nous utilisons des piéces neuves ou des piéces a I'état neuf. Le cas échéant, les
piéces retirées de I'appareil nous appartiennent et peuvent étre détruites.

3. En plus de cette garantie, le client dispose pleinement des droits relatifs a la garantie légale de conformité sur la
base du contrat de vente conclu avec le distributeur/revendeur qui lui sont conférés par la loi. La garantie légale de
conformité ne concerne que la qualité de la marchandise au moment de la vente (transfert), contrairement a notre
garantie fabricant.

4. Vous ne pouvez faire valoir cette garantie que lorsque vous envoyez a vos frais 'appareil défectueux accompagné
d’une preuve d’achat (facture ou ticket de caisse) a Auerswald GmbH & Co. KG ou, hors d’Allemagne, a notre
importateur général ou distributeur sur place. Veuillez joindre a cet envoi une description détaillée du défaut ainsi que
votre numéro de téléphone afin que nous puissions vous contacter au besoin. Afin d’éviter tout dommage lors du
transport, veuillez vous assurer que I'appareil est placé dans un emballage adapté (par ex. emballage original placé
dans un carton).

5. Les dommages résultant d’une utilisation non conforme, d’erreurs de manipulation, d’'une utilisation abusive,
d'influences extérieures, de la foudre/d’une surtension, d’'une modification du produit et d’'ajouts, sont exclus de la
garantie fabricant. Les piéces d'usure sont également exclues de la garantie (par ex. piles, fusibles, batteries, cartes
mémoires), tout comme les dommages résultant des pieces d’'usures (par ex. en raison de piles déchargées). Les
dommages résultant du transport, les dommages consécutifs ainsi que les codts liés aux temps d’attente et
d’acheminement, sont également exclus de la garantie fabricant.

6. La garantie est rendue caduque lors de I'exécution de réparations effectuées par des organismes non autorisés.

Premiére mise en service

Raccordez le téléphone comme représenté sur l'illustration sous
Raccordement.

Premiére configuration du téléphone
Prérequis :

* Numéros d’appel internes paramétrés dans le systéme de
télécommunication

Suivez les indications dans le téléphone.



Remarque: Le MSN est le numéro d’appel interne paramétré dans le
systeme de télécommunication.

Configuration via le COMfortel Set

Prérequis :

» Java Runtime est installé (disponible sur notre site Internet)
» COMfortel Set est installé (disponible sur notre site Internet)
+ Connexion existante du PC au téléphone

— Via une interface PC du systéme de télécommunication (cf. notice du
systeme de télécommunication)

— Ou directement via le port USB du téléphone (*<=*)

Remarque: En cas d'utilisation du port USB, il faut d’abord installer le pilote
USB sur le PC (cf. notice « Advanced Information »).

1. Lancez le programme.

2. Sous Options > Interface, sélectionnez I'interface que vous utilisez (par
ex. Réseau IP lors de la connexion du PC avec le systéme de
télécommunication via le réseau local).

Cliquez sur Ouvrir > Téléphone et sélectionnez le téléphone concerné.
Entrez le code PIN.
Effectuez les réglages souhaités.

Enregistrez ensuite la configuration dans le téléphone. Cliquez enfin sur
Fichier > Enregistrer > Téléphone dans cet ordre.

I o



Italiano

Informazioni importanti

Indicazioni di sicurezza

Avvertenza: L’'uso improprio del dispositivo pud causare una scossa
elettrica mortale e danneggiare o distruggere il dispositivo.

* Leggere e conservare le guide fornite insieme al dispositivo.

» Collegare il cavo del dispositivo solo a prese idonee e installate a regola

d’arte.

+ Utilizzare esclusivamente accessori e ricambi originali.

Avvertenza: Un’eventuale configurazione incompleta o errata puo

risultare pericolosa per gli utenti, per es. nel caso in cui non sia
possibile effettuare le chiamate di emergenza.

« |l prodotto pud essere configurato tramite il telefono o tramite il software
COMfortel Set. La guida corrispondente € disponibile in lingua inglese o
tedesca. In caso di scarsa padronanza di tali lingue e dei termini tecnici
utilizzati, rivolgersi a un tecnico con conoscenze linguistiche adeguate.

Avvertenza: L’uso di un alimentatore a spina inadeguato puo causare
una scossa elettrica mortale e danneggiare o distruggere il telefono.
« Ultilizzare solo 'alimentatore a spina di tipo FW7577/EU/40.
Avvertenza: La penetrazione di liquidi nel dispositivo pud causare
una scossa elettrica mortale e danneggiare o distruggere il dispositivo.
« Ultilizzare il telefono solo in locali chiusi e asciutti.
+ Pulire il dispositivo solo con un panno leggermente inumidito o un panno
antistatico.

Avvertenza: | cavi di collegamento danneggiati, cosi come eventuali
danni in corrispondenza dell’involucro e del dispositivo, possono
causare una scossa elettrica mortale.

» Non mettere in funzione un dispositivo danneggiato.
Avvertenza: Le sovratensioni, per esempio quelle che si formano
durante i temporali, possono causare una scossa elettrica mortale e
danneggiare o distruggere il dispositivo.

» Durante i temporali evitare di toccare il dispositivo.

» Tutti i cavi dell'edificio devono essere posati da un elettricista qualificato.
Avvertenza: Cuffie auricolari, altoparlanti esterni o ricevitori

inadeguati possono danneggiare I'udito o disturbare il collegamento
audio.

» Rispettare i dati tecnici per il collegamento di una cuffia auricolare.



Avvertenza: Gli oggetti attirati dal debole campo magnetico del
ricevitore, come puntine e fermagli, possono causare lesioni.

* Non appoggiare il ricevitore in prossimita di tali oggetti.

@ Avvertenza: Pericolo di soffocamento. Il dispositivo contiene
QB particolari di piccole dimensioni che possono essere inghiottiti dai
bambini.

» Tenere il dispositivo fuori dalla portata dei bambini.

Importante: Il dispositivo non € progettato per sistemi vitali e/o per
applicazioni nell’ambito di impianti nucleari e pertanto non deve essere
utilizzato a tali scopi. L'uso del dispositivo per applicazioni di questo tipo
presuppone obbligatoriamente la presenza di un consenso/una
dichiarazione scritti del produttore per il caso specifico.

L’uso improprio puo limitare le funzioni del dispositivo, causarne un

malfunzionamento o la distruzione oppure, nel peggiore dei casi, creare

situazioni pericolose per le persone.

* Qualora, anche dopo avere letto il capitolo seguente, permangano dubbi
sull’'uso previsto, rivolgersi al proprio rivenditore specializzato.

+ Leggere le guide fornite insieme al dispositivo e conservarle per ogni
utilizzo futuro.

» Per usufruire di alcune funzioni pud essere necessario richiedere
un’attivazione presso I'operatore di rete, eseguire un aggiornamento del
firmware e/o eseguire una configurazione tramite COMfortel Set.

Uso previsto

Telefono di sistema da collegare alla porta Sy 0 Upg interna di un centralino
Auerswald/FONtevo (vedere i dati tecnici). Il collegamento a un centralino di un
altro produttore o alla porta Sy esterna di un operatore di rete non & consentito.
I telefono fisso € progettato per essere utilizzato in locali chiusi e asciutti.

Dati tecnici
Tensione di Alimentazione dal centralino tramite porta Sy 0 Upg
funzionamento interna; con COMfortel Xtension300: necessaria

alimentazione tramite alimentatore a spina; 230 V ~;
+/- 10%, 50 Hz

Alimentatore a Tipo n. FW7577/EU/40
spina

Potenza assorbita | Min. 1,1 W, max. 1,9 W; COMfortel Xtension300:
+0,6 W




Collegamento al
sistema

Porta Sy 0 Upg interna dei centralini: COMpact 3000
analogico/ISDN/VolP, COMpact 2206 USB,
COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000,

COMpact 5000/R, COMpact 5200/R,

COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Interfaccia PC/dati

usB

Display 18 LED, 15 dei quali a piu colori, display a colori TFT
da 4,3”, 480 x 272 pixel, retroilluminazione
COMfortel Xtension300: 30 LED, a piu colori

Elementi di Tastiera, 12 tasti funzione fissi, display a colori con

comando funzione touch, tastierino direzionale, 15 tasti
funzione programmabili con LED (ciascuno con un
massimo di due funzioni assegnabili su due livelli)
COMfortel Xtension300: 30 tasti funzione
programmabili

Ricevitore Audio a banda larga, microfono a electret, ricevitore

con altoparlante dinamico, compatibile con
apparecchio acustico

Cuffia auricolare

Interfaccia separata per cuffie auricolari via cavo,
anche con supporto della tecnologia wireless (DHSG)

Commutatore a

Contatto di commutazione magnetico

forchetta

Involucro Plastica, nera, bianca

Dimensioni 275 mm x 128/150/170 mm x 210 mm;

(Lax AxP) COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Peso Circa 1050 g; COMfortel Xtension300: circa 310 g

Temperatura Funzionamento: da 0 a 40 °C, stoccaggio: da -30 a
+70 °C, senza formazione di condensa

Sicurezza CE

Dati tecnici per il collegamento di una cuffia auricolare

Assorbimento di corrente del microfono Max. 0,5 mA
Sensibilita del microfono -45dB
Impedenza degli altoparlanti 150 Ohm
Sensibilita degli altoparlanti a 1 kHz 19,5 +/- 3 dBPa/V
Limite del livello sonoro 24 dBPa




Note di carattere ambientale

Qualora il dispositivo non serva piu, smaltirlo a regola d’arte (non insieme ai
normali rifiuti domestici).

&Y. Smaltire il materiale dell’imballaggio nel rispetto dell’ambiente e delle
%9 norme vigenti in materia.

E Informarsi presso le autorita locali o comunali sulle modalita di
smaltimento corrette ed ecologiche del dispositivo. Su richiesta,
Auerswald puo farsi carico dello smaltimento. Per avvalersi di tale
possibilita spedire il dispositivo a proprie spese ad Auerswald GmbH & Co. KG.

Dichiarazione di conformita

Il presente dispositivo soddisfa i requisiti fondamentali in materia di salute,
sicurezza e ambiente di tutte le direttive europee applicabili. La dichiarazione
di conformita pud essere consultata in Internet.

Condizioni di garanzia

1. In qualita di produttore, Auerswald GmbH & Co. KG, Vor den Grashdfen 1, 38162 Cremlingen, Germany, concede
su questo prodotto 24 mesi di garanzia del produttore a partire dalla data di acquisto.

2. Per il consumatore questo significa che: garantiamo la consegna di dispositivi privi di difetti € provvediamo alla loro
riparazione o sostituzione gratuita qualora emerga un difetto di produzione per 24 mesi a partire dalla data di
consegna. Facciamo a meno della prova che il consumatore deve fornire ai sensi della garanzia di legge a
dimostrazione che il difetto era gia presente al momento della consegna. Per la riparazione o la fornitura sostitutiva
utilizziamo componenti nuovi o come nuovi. | componenti eventualmente rimossi dal dispositivo diventano di nostra
proprieta e possono essere distrutti.

3. Oltre alla presente garanzia, al cliente spettano tutti i diritti di legge nei confronti del fornitore risultanti dalla garanzia
per vizi della cosa venduta sulla base del contratto di compravendita. A differenza della garanzia del produttore da noi
concessa, la garanzia di legge per i vizi della cosa venduta riguarda unicamente le condizioni al momento della vendita
(consegna).

4. E possibile usufruire della presente garanzia solo inviando ad Auerswald GmbH & Co. KG o, se vi trovate al di fuori
della Germania, al nostro importatore generale o distributore locale, il dispositivo difettoso unitamente a un documento
giustificativo dell'acquisto (fattura o scontrino inequivocabili). Allegare all'invio anche una descrizione dettagliata del
difetto e riportare il proprio numero di telefono per eventuali richieste di chiarimento. Per evitare che il dispositivo
subisca danni durante il trasporto, imballarlo adeguatamente (per es. inserire il dispositivo nell'imballaggio originale,
quindi allinterno di un’ulteriore scatola di cartone).

5. La garanzia del produttore non copre i danni causati da gestione inadeguata, errore di azionamento, uso improprio,
influssi esterni, fulmini/sovratensioni, modifiche del prodotto e aggiunta di componenti. La garanzia non si applica ai
componenti soggetti a usura (per es. batterie, fusibili, batterie ricaricabili, schede di memoria) e non copre eventuali
danni causati da tali componenti (per es. in seguito all’esaurirsi delle batterie). La garanzia non copre neppure i danni
di trasporto, i danni indiretti e i costi subiti in seguito ai tempi di fuori servizio e di transito.

6. Eventuali riparazioni eseguite da centri non autorizzati provocano la decadenza del diritto alla garanzia.

Prima messa in funzione
Collega il telefono come illustrato nella figura riportata sotto a “Collegamento”.

Prima configurazione del telefono

Requisiti:

» numero di telefono interno configurato nel centralino.
Segqui le istruzioni sul telefono.

Nota: L'MSN ¢ il numero di telefono interno configurato nel centralino.




Configurazione tramite COMfortel Set

Requisiti:

+ Java Runtime installato (sono disponibili sul nostro sito web)

+ COMfortel Set installato (sono disponibili sul nostro sito web)

+ Connessione esistente tra il PC e il telefono
— Tramite un’interfaccia PC del centralino (vedere la guida del centralino)
— O direttamente tramite la presa USB del telefono (*<&*)

Nota: Se si utilizza la presa USB, & prima necessario installare sul PC il
driver USB (vedere guida “Advanced Information”).

1. Awvia il programma.

2. Alla voce Opzioni > Interfaccia seleziona l'interfaccia utilizzata (per es.
Rete IP nel caso in cui il PC sia connesso con il centralino tramite la rete

locale).
Clicca su Apri > Telefono e seleziona il telefono in oggetto.
Immetti il PIN.

Esegui le impostazioni desiderate.

quindi salva la configurazione nel telefono. Per fare cio clicca su File >
Salva > Telefono.

ook~ w



Nederlands

Belangrijke informatie

Veiligheidsinstructies

Waarschuwing: Verkeerde omgang met het apparaat kan
levensgevaarlijke elektrische schokken tot gevolg hebben en het
apparaat beschadigen.
* Lees de bij het apparaat behorende handleidingen door en bewaar deze.
+ Sluit de aansluitkabel van het apparaat alleen aan op de daarvoor
bedoelde en deskundig geinstalleerde contactdozen

» Gebruik uitsluitend originele toebehoren en originele reservedelen.

Waarschuwing: Onvolledige of verkeerde configuratie kan gevaar
voor personen tot gevolg hebben, bijvoorbeeld doordat noodoproepen
niet kunnen worden uitgevoerd.

« De configuratie van het apparaat geschiedt via de telefoon of via de
software COMfortel-set. De bijbehorende hulp is beschikbaar in de
Engelse of de Duitse taal. Wanneer u niet bekend bent met deze talen en
de gebruikte vaktermen, schakel dan een vaktechnicus in die deze wel
beheerst.

Waarschuwing: Het gebruik van de verkeerde adapter kan
levensgevaarlijke elektrische schokken tot gevolg hebben en de
telefoon beschadigen of kapot maken.

» Gebruik enkel de adapter met type-nr. FW7577/EU/40.
Waarschuwing: Vloeistof dat de behuizing binnendringt kan

levensgevaarlijke elektrische schokken tot gevolg hebben en het
apparaat beschadigen.
* Gebruik de telefoon alleen in gesloten, droge ruimten.
* Reinig het apparaat alleen met een licht vochtige doek of een antistatische
doek.

Waarschuwing: Beschadigde aansluitkabels en beschadigingen aan
de behuizing en aan het apparaat zelf, kunnen levensgevaarlijke
elektrische schokken tot gevolg hebben.

* Neem een beschadigd apparaat nooit in bedrijf.
Waarschuwing: Overspanningen, zoals bij onweer kunnen optreden,

kunnen levensgevaarlijke elektrische schokken tot gevolg hebben of
het apparaat beschadigen of kapot maken.

* Raak het apparaat niet aan tijdens een onweersbui.
+ Laat door een elektrotechnicus alle kabels binnen het gebouw installeren.



Waarschuwing: Ongeschikte headsets, externe luidsprekers of
koptelefoons kunnen tot gehoorschade leiden of de spraakverbinding
storen.
* Neem de technische gegevens voor het aansluiten van een headset in
acht.

Waarschuwing: Het zwakke magnetische veld in de koptelefoon kan
objecten als naalden en paperclips aantrekken. Deze objecten kunnen
letsel veroorzaken.

» Leg de koptelefoon niet in de buurt van dergelijke objecten neer.

Qé) Waarschuwing: Verstikkingsgevaar. Het apparaat bevat kleine
Q onderdelen die door kleine kinderen kunnen worden ingeslikt.

* Houd het apparaat buiten bereik van kleine kinderen

Belangrijk: Het apparaat is niet bedoeld, en mag daarom niet worden
gebruikt, voor life-support systemen en/of toepassingen binnen nucleaire
inrichtingen. Voor gebruik van het apparaat in dergelijke toepassingen moet
verplicht een op het individuele geval afgestemde schriftelijke toestemming/
verklaring van de fabrikant vooraf worden afgegeven.

Niet correct gebruik kan bijvoorbeeld functiebeperkingen of storingen,

onherstelbare schade aan het apparaat of, in het ergste geval, gevaar voor

personen tot gevolg hebben.

* Wanneer u betreffende het correcte gebruik, ook na het lezen van het
volgende hoofdstuk, nog twijfelt, neem dan contact op met uw dealer.

* Lees de bij het apparaat behorende handleidingen door en bewaar deze
voor later gebruik.

» Voor het gebruik van bepaalde functies is een vrijschakeling bij de
netbeheerder, een firmware-update en/of een configuratie via de
COMfortel Set vereist.

Correct gebruik

Systeemtelefoon voor aansluiting op de interne Sy- of Upg-poort van een
telefooncentrale van Auerswald/FONtevo (zie technische gegevens). De
verbinding is niet bedoeld voor aansluiting op een telefooncentrale van een
andere fabrikant of op de externe Sy-aansluiting van een netbeheerder. De
bedrade telefoon is bedoeld om in gesloten, droge ruimten te worden gebruikt.

Technische gegevens

Bedrijfsspanning Voeding via interne Sp- of Upg-poort uit de
telefooncentrale; met COMfortel Xtension300:
Voeding via adapter vereist; 230 V ~; +/- 10 %, 50 Hz

Adapter Type-Nr. FW7577/EU/40

Opgenomen Min. 1,1 W, max. 1,9 W; COMfortel Xtension300:
vermogen +0,6 W




Systeemaansiluiting

Interne Sy- of Upg-poort van de telefooncentrale:
COMpact 3000 analog/ISDN/VolP, COMpact 2206
USB, COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000,

COMpact 5000/R, COMpact 5200/R,

COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

PC-/data-interface

usB

Weergave

18 LEDs, waarvan 15 meerkleurig, 4,3 inch TFT-
kleurendisplay, 480 x 272 pixel,
achtergrondverlichting

COMfortel Xtension300: 30 LEDs, meerkleurig

Bedieningselementen

Toetsenblok, 12 vaste functietoetsen, kleurendisplay
met touch-functie, besturingspaneel, 15
programmeerbare functietoetsen met LED (met elk
tot twee functies die op twee niveaus toewijsbaar zijn)

COMfortel Xtension300: 30 programmeerbare
functietoetsen

Hoorn Wideband audio, elektretmicrofoon, dynamische
luidspreker handset, compatibel met
gehoorapparaten

Headset Afzonderlijke interface voor bedrade headsets, ook

met ondersteuning voor draadloze headsets (DHSG)

Telefoonhaak

Magnetisch schakelcontact

Behuizing Kunststof, zwart, wit

Afmetingen 275 mm x 128/150/170 mm x 210 mm;

(B xHxD) COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Gewicht Ca. 1050 g; COMfortel Xtension300: ca. 310 g

Temperatuur Bedrijf: 0 tot 40 °C, opslag: - 30 tot + 70 °C, niet
condenserend

Veiligheid CE

Technische gegevens voor het aansluiten van een headset

Stroomverbruik microfoon Max. 0,5 mA
Gevoeligheid microfoon -45dB
Impedantie luidspreker 150 Ohm
Gevoeligheid luidspreker bij 1 kHz 19,5 +/- 3 dBPa/V
Grens geluidsniveau 24 dBPa




Milieuvoorschriften

Wanneer het apparaat eens is uitgediend, let dan op een correcte afvoer (niet
in het normale huisvuil).

&y Voer het verpakkingsmateriaal correct af om het milieu te sparen.

Informeer bij uw lokale autoriteiten naar de mogelijkheden voor het
milieuvriendelijk afvoeren van uw apparaat. Wanneer u wilt, dat wij het

=== apparaat voor u afvoeren, stuur het apparaat dan voor uw eigen rekening
naar Auerswald GmbH & Co. KG.

Conformiteitsverklaring
Dit apparaat voldoet aan de principiéle gezondheids-, veiligheids- en

milieuvoorschriften uit alle relevante Europese richtlijnen. De
conformiteitsverklaring kan op internet worden ingezien.

Garantievoorwaarden

1. Auerswald GmbH & Co. KG, Vor den Grashéfen 1, 38162 Cremlingen, Germany, verleent als fabrikant op dit
product 24 maanden fabrieksgarantie vanaf de koopdatum.

2. Dit betekent voor u als gebruiker: Wij garanderen, dat onze apparaten bij de overdracht foutloos functioneren en
zorgen tot 24 maanden vanaf deze datum voor een kostenloze reparatie of wij leveren kosteloos een vervangen, indien
een fabricagefout optreedt en zien af van het door u als verbruiker aan te voeren bewijs als bij de wettelijke garantie,
dat deze fout op het tijdstip van overdracht al aanwezig was. Bij de reparatie of de levering van vervangende
onderdelen gebruiken wij nieuwe of gelijkwaardige onderdelen. Het apparaat en eventueel uitgenomen onderdelen
gaan over in ons eigendom en mogen worden vernietigd.

3. Naast deze garantie heeft de klant in volledige omvang het wettelijke recht op garantie op basis van het koopverdrag
ten opzichte van de leverancier. De wettelijke garantie betreft echter in tegenstelling tot onze fabrieksgarantie alleen
de kwaliteit op het tijdstip van verkoop (overdracht).

4. U kunt alleen aanspraak maken op deze garantie, wanneer u het defecte apparaat met een eenduidig koopbewijs
(factuur of kassabon) op uw kosten aan Auerswald GmbH & Co. KG verzendt of, buiten Duitsland, aan onze importeur
of distributeur ter plaatse. Voeg aan deze zending een uitgebreide foutbeschrijving tot en vermeld voor eventuele
vragen ook uw telefoonnummer. Zorg voor geschikte transportverpakking om transportschade te voorkomen
(bijvoorbeeld originele verpakking met een omdoos).

5. Uitgesloten van de fabrieksgarantie is schade, die ontstaat door verkeerde behandeling, bedieningsfouten,
misbruik, externe invioeden, blikseminslag/overspanning, veranderingen van het product en aangebouwde
componenten. Bovendien zijn de slijtende delen uitgesloten (bijv. batterijen, zekeringen, accu's, geheugenkaarten), en
door de slijtende delen veroorzaakte schade (bijv. door het uitlopen van batterijen). Ook transportschade,
gevolgschade en kosten voor uitvaltijden zijn uitgesloten.

6. De garantie komt te vervallen wanneer reparaties door niet geautoriseerde instanties worden uitgevoerd.

Eerste ingebruikname

Sluit de telefoon aan zoals op de afbeelding onder aansluiting wordt
weergegeven.

Eerste configuratie via de telefoon

Voorwaarden:

+ Bij de telefooncentrale ingesteld intern telefoonnummer
Volg de instructies in de telefoon.

Opmerking: De MSN is het in de telefooncentrale ingestelde interne
telefoonnummer.




Configuratie via COMfortel Set

Voorwaarden:

+ Java Runtime geinstalleerd (deze vindt u op onze internetpagina)
+ COMfortel Set geinstalleerd (deze vindt u op onze internetpagina)
+ Bestaande aansluiting van de pc op de telefoon

— Via een pc-interface van de telefooncentrale (zie de handleiding van de
telefooncentrale)

— Of direct via de USB-poort van de telefoon (*<=*)

Opmerking: Bij gebruik van de USB-poort moet op de pc eerst het USB-
stuurprogramma worden geinstalleerd (zie instructies "Advanced
Information").

1. Start het programma.

2. Selecteer onder Options > Interface de door u gebruikte interface (bijv. IP
network als de PC middels het lokale netwerk met de telefooncentrale is
verbonden).

Klik op Open > Telephone en selecteer de betreffende telefoon.
Voer de PIN in.
Voer de gewenste instellingen door.

Sla hierna de configuratie op in de telefoon. Klik hiervoor
achtereenvolgens op File > Save > Telephone.

ook~



Polski

Wazne informacje

Wskazéwki bezpieczenstwa

Ostrzezenie: Nieprawidtowe uzywanie urzgdzenia moze
doprowadzi¢ do groznego dla zycia porazenia prgdem, a takze
uszkodzi¢ lub zniszczy¢ urzadzenie.

* Nalezy przeczytaé zatgczone instrukcje obstugi urzadzenia i zachowac je.

* Przewody urzgdzenia nalezy podtgcza¢ wytgcznie do odpowiednich i
fachowo zainstalowanych gniazd przytaczeniowych

» Nalezy uzywac wytacznie oryginalnych akcesoridow i czesci zamiennych.

Ostrzezenie: Niekompletna lub btedna konfiguracja moze prowadzi¢
do zagrozenia zycia, np. poprzez brak mozliwosci wykonania
potgczenia w celu wezwania pomocy.

« Konfiguracja produktu odbywa sie przez telefon lub przez
oprogramowanie COMfortel Set. Wtasciwa pomoc jest dostepna w jezyku
angielskim lub niemieckim. Jezeli te jezyki i zastosowane fachowe pojecia
sprawiajg trudnosc, to nalezy powierzy¢ te czynnosci osobie z
odpowiednimi kwalifikacjami jezykowymi i fachowymi.

Ostrzezenie: Uzywanie niewlasciwego wtykowego zasilacza
sieciowego moze doprowadzi¢ do groznego dla zycia porazenia
pradem, a takze uszkodzi¢ lub zniszczy¢ telefon.

» Stosowac tylko wtykowy zasilacz sieciowy o nr. typu FW7577/EU/40.

Ostrzezenie: Zalanie obudowy ptynem moze doprowadzi¢ do

Smiertelnego porazenia prgdem, a takze uszkodzi¢ lub zniszczy¢
urzgdzenie.

« Telefonu nalezy uzywaé wytacznie w zamknietych i suchych
pomieszczeniach.

» Urzadzenie nalezy czysci¢ wylgcznie za pomoca lekko zwilzonej szmatki
lub Sciereczki antystatycznej.
Ostrzezenie: Uszkodzenia przewoddw, obudowy lub urzgdzenia
mogg prowadzi¢ do $miertelnego porazenia prgdem.
* Nie nalezy wtgczaé uszkodzonego urzgdzenia.
Ostrzezenie: Wystepujgce podczas burzy przepiecia moga

doprowadzi¢ do $miertelnego porazenia prgdem, a takze uszkodzi¢
lub zniszczy¢ urzadzenie.

* W czasie burzy nie nalezy dotykaé¢ urzadzenia.

* Rozmieszczaniem przewodéw w budynku powinien zajgc¢ sie
wykwalifikowany elektryk.



Ostrzezenie: Nieodpowiednie zestawy stuchawkowe, zewnetrzne
gtosniki lub stuchawki moga prowadzi¢ do uszkodzenia stuchu lub
powodowac¢ zaktdcenia potgczen gltosowych.

* Przestrzegac¢ danych technicznych dotyczacych podtgczania zestawu
stuchawkowego.

Ostrzezenie: Przedmioty przyciggniete przez stabe pole
magnetyczne w stuchawce, takie jak igty lub spinacze biurowe, mogg
spowodowac¢ skaleczenia.

* Nie nalezy umieszczac¢ stuchawki w poblizu takich przedmiotow.

Qé) Ostrzezenie: Niebezpieczenstwo uduszenia. W urzgdzeniu znajdujg
Q sie drobne elementy, ktére dzieci mogg potknac.

+ Urzgdzenie nalezy przechowywac¢ poza zasiegiem matych dzieci

Wazne: Niniejsze urzadzenie nie jest przeznaczone do uzytku w systemach
podtrzymywania zycia i/lub w urzgdzeniach nuklearnych i nie powinno by¢ w
nich stosowane. Aby niniejsze urzadzenie mogto by¢ wykorzystywane do
tego typu zastosowan, dla kazdego pojedynczego przypadku bezwzglednie
wymagana jest uprzednia pisemna zgoda lub o$wiadczenie ze strony
producenta.

Uzytkowanie niezgodne z przeznaczeniem moze prowadzi¢ np. do

ograniczenia funkcjonalnosci, zaktécen w dziataniu urzadzenia, jego

zniszczenia, a w skrajnym wypadku do zagrozenia zycia.

+ Jezeli po przeczytaniu ponizszego rozdziatu nadal zachodzg watpliwosci
co do zgodnego z przeznaczeniem uzytkowania urzadzenia, nalezy
zasiegnac¢ informacji u sprzedawcy.

» Nalezy przeczytaé zatgczone instrukcje obstugi urzadzenia i zachowac je
do pézniejszego uzytku.

» Do korzystania z niektérych funkcji konieczna jest ich aktywacja u
operatora sieci, aktualizacja oprogramowania sprzetowego i/lub
konfiguracja przez COMfortel Set.

Uzytkowanie zgodne z przeznaczeniem

Telefon systemowy do podtgczania do wewnetrznego portu Sy lub Upq centrali
telefonicznej firmy Auerswald/FONtevo (patrz Dane techniczne). Podtgczenie
do centrali telefonicznej innego producenta lub do zewnetrznego przytgcza S,
operatora sieci nie jest przewidziane. Jest to telefon przewodowy,
przeznaczony do uzytku w zamknigetych i suchych pomieszczeniach.

Dane techniczne

Napiecie robocze | Zasilanie przez wewnetrzny port Sg lub Upq z centrali
telefonicznej; z COMfortel Xtension300: konieczne
zasilanie przez wtykowy zasilacz sieciowy; 230 V ~;
+/-10%, 50 Hz

Wtykowy zasilacz | Nr typu FW7577/EU/40
sieciowy




Pobér mocy Min. 1,1 W, maks. 1,9 W; COMfortel Xtension300:
+0,6 W

Przytacze Wewnetrzny port Sy lub Upq central telefonicznych:

systemowe COMpact 3000 analog/ISDN/VolP, COMpact 2206

USB, COMpact 4410 USB, COMpact 5010 VolP,
COMpact 5020 VolP, COMpact 4000,

COMpact 5000/R, COMpact 5200/R,

COMpact 5500R, COMmander 6000/R/RX.
COMmander Basic 2/19", COMmander Business/19"

Ztacze komputera/
danych

usSB

Wskazniki

18 diod LED, w tym 15 wielokolorowych; wyswietlacz
kolorowy TFT 4,3 cala, 480 x 272 piksele,
podswietlenie tla

COMfortel Xtension300: 30 diod LED,
wielokolorowych

Elementy obstugi

Klawiatura przyciskowa, 12 przyciskéw statych,
wyswietlacz kolorowy z obstuga dotykowa, podktadka
kierunkowa, 15 programowalnych przyciskow funkgiji
z diodg LED (mozliwos¢ przypisania maksymalnie
dwdch funkcji na dwdch poziomach)

COMfortel Xtension300: 30 programowalnych
przyciskow funkciji

Stuchawka Dzwigk szerokopasmowy, mikrofon elektretowy,
dynamiczny gtosnik stuchawki, kompatybilny z
aparatami stuchowymi

Zestaw Osobne zigcze dla przewodowych zestawow

stuchawkowy stuchawkowych, réwniez z obstugg DHSG

Przetacznik Magnetyczny zestyk przetgczny

aparatowy

Obudowa Tworzywo sztuczne, czarny, biaty

Wymiary 275 mm x 128/150/170 mm x 210 mm;

(szer. x wys. x gt.)

COMfortel Xtension300: 120 mm x 68/90/110 mm x
210 mm

Waga

Ok. 1050 g; COMfortel Xtension300: ok. 310 g

Temperatura

Eksploatacja: od 0 do 40 °C, przechowywanie: od -30
do +70 °C, bez kondensaciji

Zabezpieczenia

CE

Dane techniczne przylgcza zestawu stuchawkowego

Pobér pradu przez mikrofon

| Maks. 0,5 mA

Czuto$¢ mikrofonu

|-45dB



Impedancja gtosnikow 150 omoéw
Czutos¢ gtosnikow przy 1 kHz 19,5 +/- 3 dBPa/V

Granica poziomu dzwieku 24 dBPa

Informacje dotyczace ochrony srodowiska

Po zakohczeniu uzytkowania urzgdzenia nalezy zadbaé o jego odpowiednig
utylizacje (oddzielnie od odpadéw komunalnych).

&y Materiat opakowaniowy nalezy zutylizowaé w sposéb zgodny z zasadami
9 ochrony srodowiska.
W administracji miasta lub gminy nalezy zasiegna¢ informacji o
mozliwosci prawidtowej utylizacji urzadzenia, zgodnej z zasadami
ochrony $rodowiska. Urzgdzenie, ktére ma zosta¢ zutylizowane, mozna
réwniez przesta¢ na swoj koszt do firmy Auerswald GmbH & Co. KG.

Deklaracja zgodnosci

Niniejsze urzgdzenie spetnia podstawowe wymagania dotyczgce zdrowia,
bezpieczenstwa i ochrony srodowiska naturalnego wszystkich wtasciwych
dyrektyw europejskich. Z tg deklaracjg zgodnosci mozna zapoznac sie w
Internecie.

Warunki gwarancji

1. Spétka Auerswald GmbH & Co. KG, Vor den Grashdéfen 1, 38162 Cremlingen, Germany, przyznaje jako producent
24-miesigczng gwarancje producenta na ten produkt, ktéra rozpoczyna sig¢ w dniu zakupu.

2. Dla Panstwa jako konsumenta oznacza to, co nastepuje: Gwarantujemy, ze nasze urzadzenia w momencie ich
przekazania nie posiadajg usterek, i zapewniamy bezptatng naprawe lub darmowg wymiane w ciggu 24 miesigcy od
tej daty, w przypadku gdy w urzadzeniu wykryta zostanie wada fabryczna, i rezygnujemy z obowigzku przedstawienia
przez Panstwa jako konsumenta dowodu, ze dana usterka wystgpowata juz w momencie przekazania produktu, co
jest wymagane w przypadku ustawowej rekojmi. W przypadku naprawy lub wymiany uzywamy nowych czesci lub
czesci posiadajgcych warto$é nowego produktu. Ewentualne czes$ci wymontowane z urzadzenia stajg sie naszg
wiasnoscig i mogg zosta¢ zutylizowane.

3. Oprécz niniejszej gwaranciji klientowi w petnym zakresie przystugujg ustawowe prawa z tytutu rekojmi przyznawanej
na mocy umowy sprzedazy zawartej z dostawca. W przeciwienstwie do naszej gwarancji producenta ustawowa
rekojmia dotyczy tylko jako$ci w momencie sprzedazy (przekazania).

4. Z niniejszej gwarancji moga Panstwo skorzysta¢ wytgcznie po przestaniu wadliwego urzgdzenia na wtasny koszt
wraz z jednoznacznym dowodem zakupu (rachunkiem lub paragonem) do firmy Auerswald GmbH & Co. KG badz do
naszego importera generalnego lub miejscowego dystrybutora, w przypadku klientéw spoza Niemiec. Prosimy takze
o dotgczenie do wysytki szczegétowego opisu uszkodzenia i o podanie numeru telefonu do kontaktu w przypadku
ewentualnych pytan. Aby unikngé uszkodzen w transporcie, nalezy zadba¢ o odpowiednie opakowanie na czas
transportu (np. opakowanie oryginalne i karton zewnetrzny).

5. Gwarancjg producenta nie sg objete szkody, ktére powstajg na skutek niewtasciwego uzytkowania, btedu operatora,
naduzywania, czynnikéw zewnetrznych, uderzenia pioruna/przepigcia, modyfikacji produktu lub jego rozbudowy.
Ponadto gwarancja nie obejmuje czesci ulegajacych zuzyciu (np. baterii, bezpiecznikéw, akumulatoréw, kart pamieci),
a takze uszkodzen spowodowanych przez takie czesci (np. w wyniku wyczerpania sig baterii). Ponadto z zakresu
gwarancji wytaczone sg szkody powstate w transporcie, szkody posrednie, koszty powstate w trakcie awarii i
transportu.

6. Gwarancja wygasa w przypadku wykonania napraw w hieautoryzowanym serwisie.

Pierwsze uruchomienie

Telefon nalezy podtgczy¢ w sposdb pokazany na ilustracji w punkcie
Podtaczanie.



Pierwsza konfiguracja przez telefon

Wymagania:

+ wewnetrzny numer telefonu skonfigurowany w centrali telefonicznej
Postepuj zgodnie z instrukcjami w telefonie.

Wskazowka: MSN to wewnetrzny numer telefonu skonfigurowany w centrali
telefoniczne;.

Konfiguracja przez COMfortel Set

Wymagania:

» Zainstalowane oprogramowanie Java Runtime (dostepny na naszej stronie
internetowe;j)

+ Zainstalowane oprogramowanie COMfortel Set (dostepny na naszej stronie
internetowej)

» Nawigzane potgczenie pomiedzy komputerem a telefonem:
— Przez interfejs komputera w centrali PBX (patrz instrukcja centrali PBX),
— Albo bezposérednio przez gniazdo USB telefonu (*<=).

Wskazowka: W przypadku korzystania z gniazda USB najpierw nalezy
zainstalowac¢ na komputerze sterownik USB (patrz instrukcja ,Advanced
Information”).

1. Uruchom program.

2. W menu Options > Interface wybierz uzywany przez siebie interfejs (np.
IP network w przypadku potgczenia komputera z centralg telefoniczng
przez siec¢ lokalng).

Kliknij Open > Telephone i wybierz wtasciwy telefon.
Podaj kod PIN.
Wybierz preferowane ustawienia.

Nastepnie zapisz konfiguracje w telefonie. Kliknij po kolei File > Save >
Telephone.

I o
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